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This user’s manual contains useful information about the functions and operating
procedures of the DataBrowser and lists the handling precautions of the software. To
ensure correct use, please read this manual thoroughly before beginning operation.

After reading this manual, keep it in a convenient location for quick reference in the event
a question arises during operation.

Notes

e License numbers will not be reissued. Please keep your license numbers in a
safe place.

« The contents of this manual are subject to change without prior notice as a result
of continuing improvements to the software’s performance and functions. Display
contents illustrated in this manual may differ slightly from what actually appears on
your screen.

* Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA representative, dealer, or sales office.

< This user’s manual does not cover the handling and operating procedures of
Windows.

« Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

Trademarks

« DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or
trademarks of Yokogawa Electric Corporation.

« Microsoft, Windows, and Windows Vista are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

* Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems
Incorporated.

e Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

e The company and product names used in this manual are not accompanied by the
registered trademark or trademark symbols (® and ™).

Revisions
e 1st Edition  February 2005
e 2nd Edition  June 2007
e 3rd Edition  January 2009
e 4th Edition  June 2010
e 5th Edition  January 2011
e 6th Edition  October 2011

6th Edition : October 2011 (YK)
All Rights Reserved, Copyright © 2005 Yokogawa Electric Corporation
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Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:

THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION ("YOKOGAWA"). BY INSTALLING OR OTHERWISE USING THE
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE
THE SOFTWARE PRODUCT AND PROMPTLY RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND, IF APPLICABLE.

Software License Agreement

1. Scope

This Agreement applies to the following software products and associated documentation of Yokogawa (collectively, "Software Product"). Unless otherwise provided by
Yokogawa, this Agreement applies to the updates and upgrades of the Software Product which may be provided by Yokogawa.

Software Product: DAQWORX (It is limited to each software that you bought).

2. Grant of License

2.1 Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product on a
single or, the following specified number of, computer(s) and solely for your internal operation use, in consideration of full payment by you to Yokogawa of the license
fee separately agreed upon.

Granted number of License: 1 (one)

2.2 Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:

a) to reproduce the Software Product, except for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;

b) to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any
other person or entity;

c) to use the Software Product on any unauthorized computer via the network;

d) to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other
human readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;

e) to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or

f) to remove any copyright notice, trademark notice, logo or other proprietary notices or identification shown in the Software Product.

2.3 Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa.
Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights will be transferred to you hereunder.

2.4 You agree to maintain the aforementioned property and trade secret of Yokogawa or licensors and key codes in strict confidence, not to disclose it to any party other
than your employees, officers, directors or similar staff who have a legitimate need to know to use the Software Product and agreed in writing to abide by the obligations
hereunder.

2.5 Upon expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your
computer or media shall be deleted irretrievably. If you dispose of media in which the Software Product or its copy is stored, the contents shall be irretrievably deleted.

2.6 The Software Product may contain software which Yokogawa is granted a right to sublicense or distribute by third party suppliers, including affiliates of Yokogawa ("Third
Party Software"). If suppliers of the Third Party Software ("Supplier”) provide special terms and conditions for the Third Party Software which differ from this Agreement,
the special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier.

2.7 The Software Product may contain open source software ("OSS"), for which the special terms and conditions separately provided by Yokogawa shall take precedence
over this Agreement.

3. Restrictions on Application

3.1 Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft
operation or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation
to rail facility, nuclear related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety
standards.

3.2 If the Software Product is used for the abovementioned purposes, neither Yokogawa nor Supplier assumes liability for any claim or damage arising from the said use
and you shall indemnify and hold Yokogawa, Supplier, their affiliates, subcontractors, officers, directors, employees and agents harmless from any liability or damage
whatsoever, including any court costs and attorney's fees, arising out of or related to the said use.

4. Limited Warranty

4.1 The Software Product shall be provided to you on an “as is" basis at the time of delivery and except for physical damage to the recording medium containing the
Software Product, Yokogawa and Supplier shall disclaim all of the warranties whatsoever, express or implied, and all liabilities therefrom. If any physical defect is found
on the recording medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium free of charge, provided that the defective
medium shall be returned to the service office designated by Yokogawa at your expense within the said twelve (12) months. THIS LIMITED WARRANTY PROVIDED
IN THIS CLAUSE IS IN LIEU OF ALL OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS ALL OTHER WARRANTIES
RELATING TO THE SOFTWARE PRODUCT, WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS, ACCURACY,
RELIABILITY AND RECENCY. IN NO EVENT SHALL YOKOGAWA WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN THE
SOFTWARE PRODUCT AND OTHER SOFTWARE NOR SHALL BE LIABLE THEREFOR. The warranty provisions of the applicable law are expressly excluded to the
extent permitted.

4.2 Atthe sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number ("Upgrade") and make it available to you at your expense
or free of charge as Yokogawa deems fit. In no event shall Yokogawa be obliged to upgrade the Software Product or make the Upgrade available to you.

4.3 Certain maintenance service may be available for some types of Software Product at Yokogawa's current list price. Scope and terms and conditions of the maintenance
service shall be subject to those separately provided by Yokogawa. Unless otherwise provided in Yokogawa catalogues or General Specifications, maintenance services
will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more
than 5 years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for
more than 5 years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa
provide any service for the Software Product which has been modified or changed by any person other than Yokogawa.
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Software License Agreement

5. Infringement

5.1 |Ifyou are warned or receive a claim by a third party that the Software Product in its original form infringes any third party's patent (which is issued at the time of delivery
of the Software Product), trade mark, copyright or other intellectual property rights ("Claim"), you shall promptly notify Yokogawa thereof in writing.

5.2 If the infringement is attributable to Yokogawa, Yokogawa will defend you from the Claim at Yokogawa's expense and indemnify you from the damages finally granted
by the court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that i) you promptly notify Yokogawa
of the Claim in writing as provided above, ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and iii) you
give every and all necessary information and assistance to Yokogawa upon Yokogawa's request.

5.3 If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the
Software Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it
become non-infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value
of the Software Product as depreciated.

5.4 Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the
infringement is arising from a) modification of the Software Product made by a person other than Yokogawa, b) combination of the Software Product with hardware or
software not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa's suggestion, or ) any other causes not
attributable to Yokogawa.

5.5 This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party's intellectual
property rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special
terms and conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability

6.1 EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA AND SUPPLIERS SHALL NOT BE LIABLE TO ANY
PERSON OR LEGAL ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES,
OR OTHER SIMILAR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OR DESTRUCTION OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT,
OR ARISING OUT OF ITS GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN
WARRANTY (EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS.
IN NO EVENT YOKOGAWA AND SUPPLIER'S AGGREGATE LIABILITY FOR ANY CAUSE OF ACTION WHATSOEVER (INCLUDING LIABILITY UNDER CLAUSE
5) SHALL EXCEED THE DEPRECIATED VALUE OF THE LICENSE FEE PAID TO YOKOGAWA FOR THE USE OF THE CONCERNED PART OF THE SOFTWARE
PRODUCT. If the Software Product delivered by Yokogawa is altered, modified or combined with other software or is otherwise made different from Yokogawa
catalogues, General Specifications, basic specifications, functional specifications or manuals without Yokogawa's prior written consent, Yokogawa shall be exempted
from its obligations and liabilities under this Agreement or law.

6.2 Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the
cause of action accrues.

7. Export Control

You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa.
If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America,
and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense.

8. Audit; Withholding

8.1 Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software
Product as may be reasonably necessary in Yokogawa's opinion to verify that the requirements of this Agreement are being met.

8.2 Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of
delivery and, in Yokogawa's reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate
for you to continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment

If you transfer or assign the Software Product to a third party, you shall expressly present this Agreement to the assignee to ensure that the assignee comply with this
Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software Product in your possession
irretrievably. This Agreement shall inure to the benefit of and shall be binding on the assignees and successors of the parties.

10. Termination

Yokogawa shall have the right to terminate this Agreement with immediate effect upon notice to you, if you breach any of the terms and conditions hereof. Upon termination of
this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product,
certifying the same in writing. In this case the license fee paid by you for the Software Product shall not be refunded. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any
termination of this Agreement.

11. Governing Law; Disputes

This Agreement shall be governed by and construed in accordance with the laws of Japan.

Any dispute, controversies, or differences which may arise between the parties hereto, out of, in relation to or in connection with this Agreement ("Dispute") shall be resolved
amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either
party to the other, the Dispute shall be addressed in the following manner:

(i) If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.

(ii) If you are not a Japanese individual or entity, the Dispute shall be finally settled by arbitration in Tokyo, Japan in accordance with the Commercial Arbitration Rules
of the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of
arbitration shall be final and binding upon both parties, however, each party may make an application to any court having jurisdiction for judgment to be entered on
the award and/or for enforcement of the award.

12. Miscellaneous

12.1 This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to the
extent such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.

12.2 If any part of this Agreement is found void or unenforceable, it shall not affect the validity of the balance of the Agreement, which shall remain valid and enforceable
according to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that
achieves to the greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3 Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either in
relation to that default or any subsequent one.

End of document
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Overview of This Manual

Structure of This Manual
This manual consists of four chapters and an index as shown below.
Chapter Title Description
1 Before Using the DataBrowser  An overview of DataBrowser. Provides
DataBrowser’s PC system requirements and
configuration, flow of operations, and other

information.
2 Operation of the Data Serarch ~ Describes methods to search for data files.
Window Explains how to search by folder name, file

date, extension, data tywi, characters, serial
number, and other criteria; how to display
search results; how to add channels to data;
and other operations.

3 Operation of the Trend Display Describes how to display data found during a

Window search. Explains how to display waveforms,

cursor values, and computed results; how to
save settings and change data formats; and
other operations.

4 Responding to Error Messages Lists error messages, their causes, and their
corrective actions.
Index An alphabetical index of the manual’s contents.

Scope of This Manual
This manual does not explain the basic operations of your PC's operating system (OS).
For information regarding the basic operations of Windows, see the Windows user’s
manual.

Conventions Used in This Manual
e Unit
K:  Denotes 1024. Example: 100 KB
M: Denotes 1024 K. Example: 10 MB
G: Denotes 1024 M. Example: 2 GB

e Bolded Items
Hardware and software controls that the user manipulates such as dialog boxes,

buttons, and menu commands are often set in boldface type.

¢ Subheadings
On pages in chapters 1 through 3 that describe operating procedures, the following

subheadings are used to distinguish the procedure from their explanations.

Carry out the procedure according to the step numbers.
All procedures are written with inexperienced users in mind;

SOIEUENEIE  Gepending on the operation, not all steps need to be taken.
Explanation gives information such as limitations related the
procedure.

Note Calls attention to information that is important for proper operation
of the instrument.
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Chapter 1  Before Using the DataBrowser

1.1 Overview of DataBrowser

Functional Overview
DataBrowser is a software application providing data file searching and display functions.
It allows you to search for and display data files saved by Yokogawa recorders and data
acquisition software programs from a local or network host.

Note

Hosts on the network must be running DataBrowser.

Data Search Function (Search Window)
Five categories of search conditions are available, making entry of criteria simple. Also,

you can select multiple search conditions to refine your searches.

(1) Time
You can search for files of a specific year, month, date, and time (Time Range), or for
those of a specific time range regardless of the day (Time Range each day).

(2) File Name
Search for data files of a specified file name or extension.

(3) Data Type
Search for data files from a specific instrument (DX100/200, CX1000/2000, MX100,
MV100/200, or FX100) or data acquisition software application (DAQLOGGER,
AddTrigger, or AddMulti, MXLOGGER, MX Standard).

(4) Keywords
Search for data files containing a specified keyword(s).

(5) Serial Number
Search for data files of the specified instrument serial number.

Data Display Function (Trend Display Window)
* You can display waveforms of data having different times and acquisition intervals,

and obtained by different instruments and applications, all on the same screen.
* You can read values using cursors, and compute statistics over an area.
« Data can be converted to Excel, text, or Lotus format.
» All data, or a range of data specified by the cursor can be printed.

Diagram of Data Saving and Loading

Search results files

Trend settings
files

Search results files
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1.1 Overview of DataBrowser

Diagram of Data Searching and Display

Data on host C

DAQLOGGE -
DAQLOGGER
==\ Search

_ conditions Send
v ———— Date/time range | conditions

: (each day)
Display data File name Each host must be running
Data type DataBrowser.
Keywords
- Send

Serial numbers

. data
Convert | Print Send
data data Send Send
conditions conditions

Data on host A Host A

Send
data

)
DAQLOGGER DAQLOGGER

Communication with Network Hosts
DataBrowser can communicate with hosts on the network (other PCs running

DataBrowsers) and execute searches, obtain data, download specified files, and acquire
search results. The following is an description of the communication that occurs when
executing functions on a DataBrowser network host from another DataBrowser.

For each request, (1) a connection with the host is made, (2) the request is sent and the
response is received, (3) then the connection is closed. The connection with the host is
not always open. Rather, it only opens when the request is issued.

-$-

CXIDX/IFX

Requesting PC PC processing request
Requests conection

Allows connectiion

Sends request

Sends results of request

Closes connection
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1.2

System Requirements

Operating System (OS)
Run DAQWORX under any of the following operating systems.
e Windows 2000 Professional SP4
¢ Windows XP Home Edition SP3
e Windows XP Professional SP3 (excluding Windows XP Professional x64 Editions)
¢ Windows Vista Home Premium SP2 (excluding the 64-bit editions)
« Windows Vista Business SP2 (excluding the 64-bit editions)
¢ Windows 7 Home Premium, SP1 (32-bit and 64-bit editions)
¢ Windows 7 Professional, SP1 (32-bit and 64-bit editions)

The language displayed by the software under different language versions of the OS
are as follows.

OS Language Software Language
Japanese Japanese

Other English

Note

This manual uses screens displayed on Windows 2000 to describe the procedures.

PC
A PC that runs one of the OS above, and that meets the following CPU and memory

requirements.
When Using Windows 2000 or Windows XP
Pentium 4, 1.6 GHz or faster Intel x64 or x86 processor; 512 MB or more of memory

When Using Windows Vista
Pentium 4, 3 GHz or faster Intel x64 or x86 processor; 2 GB or more of memory

When Using Windows 7
32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86 processor; 2 GB or more of

memory
64-bit edition: Intel x64 processor that is equivalent to Intel Pentium 4, 3 GHz or faster;
2 GB or more of memory

Note

The specifications above are for a desktop PC, not a notebook PC.

Hard Disk
Free disk space: 200 MB or more

CD-ROM Dirive (for Use during Installation)

Monitor
A video card that is recommended for the OS and a display that is supported by the OS,

has a resolution of 1024x768 or higher, and that can show 65,536 colors (16-bit, high
color) or more.

Printer and Mouse
A printer and mouse supported by the OS.

Ethernet Port
An Ethernet compatible port (10BASE-T or 100BASE-TX).
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1.3 Starting and Exiting the Software

Starting the Software

Procedure

1. From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX >
DataBrowser > DataBrowser.

DataBrowser starts.

&0 e EEE
B File View Vindow Help 1 |
BEH s ER S| 7
[ Searchpaths [ Searchcondtions - - - -
T — Tine | FilzName | Data Type | Keywords | SerislNo
r [Crime -»
' @ Time Range
[C]Fite Name
-
o [CostaT:
e
i
] [keywores () Time Rangs sach day
C : NN N {
o [(Jseriaitia
[ add [ Remove | [ search subfolders. | Search | Search within resutts
[ Searchresuts — [ | FieDetails
“A4prpH M Host Name[Falder I0]
W Charnels
File Name M File Name =
Hza &
Mo Add Channel Intervallsac] size[samples] Serial No Start Tims Enet
»
T
[omen | swe | L —
Ready

When you start DataBrowser, it is restored to the same configuration that was active during the
previous session. However, the search results in memory when exiting the software cannot be
recovered in subsequent sessions.

Exiting the Software

Procedure

1. Choose File > Exit from the menu bar, or click the X] button at the right end of
the title bar.

DataBrowser closes.
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1.4

Flow of Operations

The figure below shows the general flow of operation when using DataBrowser.

See section 1.3

Start DataBrowser.

See section 2.2

folders

Register and specify search

See section 2.3 -

Specify search conditions |{7

See section 2.4 -

Execute searchs

See section 2.5 <

Display search results

See section 2.7

N Save and load search
4 conditions and result

Searches within search results

See section 2.3

Specify search conditions

See section 2.5 -

Narrow the search results

See section 2.6 <

Add channels from search
results to the trend display

See section 3.2 <

See section 3.3 -

See section 3.4 <

Select group for adding
channels

Channel display configure
screen settings

Trend display screen

See section 2.8

Dopy data files

<

il

Il

<

4

Display cursor
values

Display computed
results

Save and load
trend setting

Convert data
formats

Print the data

See section 3.5 See section 3.6 See section 3.7 See section 3.8 See section 3.9
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Chapter 2 Operation of the Data Search Window

2.1 Names of Parts in the Data Search Window

Menu bar Toolbar I'Search paths area |'Search conditions area

L =ls(x|
=181 x|

[ Search paths I* Search conditions _g
e D Tine | File Name | Deta Type | Keywords | Serial No )
[ CJime: -» =
] @ Time Range Q.
r [C]Fiie Mame // R a
F [osta Type [ zms)[ 2 e] [wr]:[o][5] g
P [eywords () Time Range each day COL ::‘
I [Dserial na. g
@)
| ac | Remove | [ search subtorers. | Search | Searoh within resuts <)
" Search resuts || Fie Details — - - Q(}))
Harp M st e s ] “Show the file information display” button-l 10}
W Channels
(Al W File Name: =2 %
EE®a & =
No Add Channel Interval[sec] Size[samples] Serial No Start Time End E
=
o
o
’ =
Resize button
| open | sae | E] | O
eady L 6 (6 L
Search results area File details area
Menu bar
| Eile Miew Wiindow | Help
(1) Opene- Ctr+0 (8) =earch display Cascade (10) About
T (9) Trend display Tile Horizontally P s i J
(2)  Mew gearch configuration A e Sehen
(3)  Mew trend configuration » Toolbar B e
» Status Bar » 1 Search - New confie.

(4)  Save search zettines az:-

2 Trend dizplay

(5)  Open the gearch results..
(6)  Save the zearch results as.

(7)  Impart Data files..

Exit

Toolbar
@ & @O @ O 6 (10)
R s ER S 2

(1) Loads search settings from local or network (6) Saves search results to the local host.
hosts and displays them. (7) Copies data files from a specified folder to

(2) Opens a new Search window. another folder.

(3) Opens a new Trend display window. (8) Displays the Search window.

(4) Saves search folder and search condition (9) Displays the Trend Display window.
settings to the local host. (10) Displays version information.

(5) Loads search results from local or network
hosts and displays them.
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2.2 Registering and Specifying Search Folders

You can register source folders for data file searches. Up to two hundred folders can be
registered, and up to eight of those can be specified at a time for a search.

Registering New Search Folders
The following is the procedure for registering new source folders for searches on local or

network hosts.

Procedure

1. Open the Search window, then click the Add button in the Search paths area.
The Search Path Configuration dialog box is displayed.

=10l ]

O Update button

B Addhuti

{:I AdeiObzerver
{:I AdadObzerver Rurtime
{:I AdedTrigoer

& DAG3IZPIUs

B DAG32Pus Cliert
& DAGEXPLORER
DAGLOGGER
7] DAGLOGGER Clisrt
{:I DataBrovweser
.70

At IR TR
Falder 1D FalderDm [ Al Close

I—Folder ID box

-

2. Select a folder to register, then enter a folder ID.

3. Click the Add button. The host name and ID of the registered folder appears in
the Search paths area (the folder’s check box is selected, indicating that it will be

included in any searches performed).

[ Search paths
— Host Mame Folder I
[+ [cPcomt-13666-01 | Folderot
] Drag to change
' the column width
L] .
[ — Select to assign folders
W to be searched
r
r
I Aled I Remove .

Explanation

Search Paths Area
Host Name
The name of the host of the registered folder.

Folder ID
The name specified for the folder when it was registered.
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2.2 Registering and Specifying Search Folders

Add button
The Search Path Configuration dialog box is displayed when this button is clicked.

Remove button
Deletes the selected folder registration from the Search paths area.

Search source check boxes
Select or clear the check boxes to include or exclude folders from searches.

Search Path Configuration Dialog Box
Update button
Updates the directory tree for the local host.
Folder ID Box
You can enter an identifying string for the folder using up to sixteen alphanumeric
characters. The folder ID is registered along with the folder.

Add button
Registers the selected folder using the specified folder ID.

Close button
Closes the Search Path Configuration dialog box.

Note

» Two or more folders cannot be registered under the same folder ID.

» Registered folders are shown under Folder List in the Registration from list tab of the Search
Path Configuration dialog box. Up to two hundred folders can be registered. If you need
to register a new folder when two hundred have already been registered, first delete one or
more of the registered folders from the folder list.

Specifying a Folder from the List

The following is the procedure for selecting a search folder from the list of registered
folders from local or network hosts.

Procedure

1. Open the Search window, then click the Add button in the Search paths area.
The Search Path Configuration dialog box is displayed.

2. Click the Registration from list tab. The Registration from list tab is displayed.

[ a = IDIiI
L ———
I Mery Registration ! Registration from list. |
Host List Q- Update button
Host Mame Update
1 CPCO01-13866-01 [localhost] ¥—1 Acquire button
2 CPCO01-05713-02 ’
— Click to select all folders
Folder List
Holt Mame CPCO0M-13666-01[10.0.106.195]
| Folder D Path Remave | &)
1 Folder001 CADACHMORM DataBrow seridatal .4 ='| Delete button
{2 Falder00z Co dataiDAGLDGGHER .4 d
i 3 Folder003 Ci\ L DataBr ove seridataiadobutty b4 =
| add || Close 1

~Double-click number to specify individual folders

“Drag to select range of folders

3. Select a host from the Host List. The folders registered under the selected host
appear in the Folder List.
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2.2 Registering and Specifying Search Folders

4. Select afolder and click Add, or double-click the folder number. The host name
and ID of the specified folder appear in the Search paths area (with check box

selected).
Search paths
Host Mame Foldet 10
CPCO0T-13666-01 | FolderD0d
PCOOM-05713-02  Folder-B001 Drag to change
the column width

Select to assign folders
to be searched

Explanation

Host List
The Host List displays any hosts on the network that are running DataBrowser. Up to
two hundred hosts can be displayed.

Folder List
The Folder List displays the folder ID and paths registered to the host selected in the
host list. Up to two hundred folders can be displayed.

Update button (red circular icon)
Updates the host list and folder list.

Update button (green arrow icon)
Updates the folder list for individual hosts.

Remove button
Deletes folders from the folder list. (You can only delete folders registered to the local
host.)

Add button
Adds the folder specified in the folder list to the Search paths list in the Search
window.

Registering a Folder from the Explorer

Procedure

1. Open the Search window. Drag a folder you wish to register from the Windows
explorer (from a folder) onto the Search window. The Reg. of search paths dialog
box is displayed.

Search window [EITrTos =lolx]
% Data = | Bls  Edt Yiew Favorkes Took Help ‘
Ei fle Vew Window Help || pag, ~ o - [ | @search | G rolders ciristory | 03 0 X w2 | B
| agdress [ 71 pagworx =] @e
[ Search paths =
(11" X || Nameg | Slzel Type -
Host Name i © =3 DAQWORK - e il | File Foldsr
r i i -1 Addmuti 1| 22 addobserver Runtime File Falder
] -] Addobserver Runtime | | Addobserver File Folder
] -] Addgbserver B il Trigger | File: Folder
W ~{_] AddTriager ClDacazrius File Folder
] -] DAGazPlus (CJoagszpius Client File: Folder
- (1] Dagazpius Client | |2 DacERPLORER File Folder
- ~{_] DAQESPLORER S " File Folder
-] DAGLOGGER CIDAGLOGGER. Cliert File Falder
C -] pAQLOGGER Tlient =
3 Detamonts 1 |CdpataBrowser File: Folder
atabroveser i
i i D Gateco’i\lTROL |_1GateCONTROL File Folder
; ; Claatepsp File Folder
e ; ; -] carimup
; ; - Gatetye gGatEEyE File Folder _|
= . T *'— H i -+ GateMODEUS HGateMODEUS File Folder
ERENTEsULS; i "D cateMxion (1 zatemx100 File Folder
i = O hd ||y Eie Erdey T
4 [r 4|l | »
[Drag folder to the search window. | K wy computer 7
TEE
Mo Add Chann
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2.2 Registering and Specifying Search Folders

Explanation

Path

o [ =] 3
Input Folder 1D,
Path Folder I
1 CALDataBrowseridataDAGLOGGERY | Folder-Coo1 —
2 CDataBrovwseridataitdoTriggery Folder-C00z ]—Enter folder ID
3 CoLDataBrowseridataidcdobiutiy Folder-C003 —_
[ aaa ][ canca |

Enter a folder ID and click the Add button. The host name and ID of the registered
folder appears in the Search paths area (the folder’s check box is selected,
indicating that it will be included in any searches performed).

The Path column shows the absolute path to the folder that was dragged.

Note

Two or more folders cannot be registered under the same folder ID.

Registered folders are shown under Folder List in the Registration from list tab of the Search
Path Configuration dialog box. Up to two hundred folders can be registered. If you need

to register a new folder when two hundred have already been registered, first delete one or
more of the registered folders from the folder list.

Notes When Registering Search Folders

Note

Even if you delete a folder from the Search paths area, the folder is not removed from the
Folder List. Likewise, even if you delete a folder from the Folder List, it is not removed from
the Search paths area.

A new folder cannot be registered under the same folder ID as one that is currently
registered in the Search paths area.

Likewise, a new folder cannot be registered under the same folder ID as one that is currently
registered in the Folder List area. However, the same folder can be registered twice under
a different folder ID.

IM WX201-01E
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2.3 Specifying Search Conditions

The following five categories of search criteria can be used. Multiple search conditions
can be specified.

Date and/or time range
File name or extension
Data type

Keywords

Serial numbers

Specifying a Date and/or Time Range

Procedure

Explanation

1. Specify a search folder. (See section 2.2)
2. Select the Time check box in the Search conditions area.

3. Click the Time tab or click the word “Time” to the right of the check box. The Time
tab is displayed.

Check box
[ Search condiions
_________________ Time | File Mame | Drata Type | Keywords | Serial Mo, |

e ™
© Time Range
[ File Maime j{ 33 =
[Jpata Type [2oos)/[ 2} 8] [n]:[s]:[e1]

|:| Keywords O Time Range each day

g Colle] - e

Search subfolders. i E’ea’ricrhiiirisieailjcrh Wrthll;réSL]Ig]

- Click to the right of each item to change the tabs on the right.
4. Select Time Range (for a specific day) or Time Range each day (for any day).

5. Enter a range of dates and time (by year, month, date, and time), or a daily time
range.

Date and time specification allows you to search for files containing data acquired on
certain dates and times.

Milliseconds cannot be specified here, and any milliseconds in files are read as “0” by
the program.

The files included by the date and time specification range are shown in the figure
below.

Given date/times A and B, the search finds any files containing data between A and B.
As long as the file contains data between A and B, it is found even if it also contains
data prior to A. Likewise, it is found if the start date/time is between A and B. Files (1),
(2), and (3) are found, but not file (4).

A B
13:00:00 15:00:00

(1)-----{ 9:00:00 to 13:00:50 | | 14:30:00 to 17:00:00 |

(2) ----meeemmn e -{13:10:00 to 14:45:00)

@) 9:00:00 to 17:00:00 |

(4)----{ 9:00:00 to 12:45:00 | | 15:00:30 |
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2.3 Specifying Search Conditions

Specifying a File Name or Extension

Procedure

1. Specify a search folder. (See section 2.2)
2. Select the File Name check box in the Search conditions area.

3. Click the File Name tab or click the words “File Name” to the right of the check
box. The File Name tab is displayed.

Check box
Search condtions
Time File Mame | Data Type | Keywords | Serial Mo
D Time: i |
PR .| @ Fiename
[ File Name mb:
"""""""" DAGLOGGER|
[oata Type
O Extension
D Heywords
D Serial Mo,
Seatch subfolders. | Search | Search within resutis |

—Click to the right of each item to change the tabs on the right.

4. Select the File Name or Extension option.

5. Enter the file name or extension to use as a search criterion.

Explanation

File name specification allows you to search for files whose names contain the specified
keyword or extension.
File Name

You can enter an entire file name or portion thereof.

Extension
You can enter an entire file name extension or portion thereof.

Note

To specify multiple files names or extensions, use a space as a delimiter. Note that wildcards (*,
?, etc.) are not allowed.
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2.3 Specifying Search Conditions

Specifying Data Types
Procedure
1. Specify a search folder. (See section 2.2)

2. Select the Data Type check box in the Search conditions area.

3. Click the Data Type tab or click the word “Data Type” to the right of the check box.
The Data Type tab is displayed.

Check box
[ Searchcondiions - - 0 - .
Time File Mame | Data Type | Keywords | Setisl Mo
[rime . | | | |
DAL OGGER Akt
|:| File: Mame
[ acdrigger [ w100
B S—— D1 004200 [ wtnineznn
"""""""" [ extoooiz000 D Frtoo
[rewwards
I:‘ Serial Ma.
Search subfolders [ Search Searchwlthlnresults 1l

L

Click to the right of each item to change the tabs on the right.

4. Select the types of data to search for.

Explanation

Data type specification allows you to search for files of the specified instrument or PC
software.

Data Types
DAQLOGGER, AddMulti, AddTrigger, MX100 (data file created on the MX100 or with
the MXLOGGER software or the MX100 standard software), DX100/DX200, MV100/
MV200, and CX1000/CX2000, FX100

Specifying Keywords
Procedure
1. Specify a search folder. (See section 2.2)

2. Select the Keyword check box in the Search conditions area.

3. Click the Keywords tab or click the word “Keywords” to the right of the check box.
The Keywords tab is displayed.

——Check box
[ Search condtions 5 5 5 = 5
Titne Filz Mame | Dats Type | Keywords | Serial Mo,
D Time. Keywords
’V Yokogawa|
[CIFie Hame
Search key
I:‘ Data Type Comment I:‘ Batch Infarmation
................. 5 Tag Comment D Tag Mo.
——E(eywords. [ channe [ croup Mame
|:| Serial No. |:| MarkMessage
Search subfolders. | Search | Search within resutts |

|-Click to the right of each item to change the tabs on the right.

4. Select a search key, then enter a keyword or keywords to search for.
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2.3 Specifying Search Conditions

Explanation

Keyword specification allows you to search for files that contain the keywords in their text

or data. Files that do not contain any data of the specified search key are not included in
the search. The table below shows the types of data available by product.

DAQLOGGER|AddMulti | AddTrigger| MX100 | DX100/200| MV100/200 | CX1000/2000 | FX100

File comments v v v v v v
Batch information v v v

Tag comments v v v v v v v v
Tag numbers v v v v

Channels v v v v v v v v
Group names v v 4 v v v v v
Marks/Messages v v v v v v v v

v’ : data type exists in data file, Blank: data type not included
Note
* You can specify multiple keywords by separating them with a space.
* If multiple search keys are selected, the software searches for files whose keywords are
found in data corresponding to all of the keys.
* Up to one thousand marks/messages can be found per file. All other marks or messages
thereafter are not found.

Specifying a Serial Number

Procedure

Explanation

1. Specify a search folder. (See section 2.2)
2. Select the Serial No. check box in the Search conditions area.

3. Click the Serial No. tab or click the words “Serial No.” to the right of the check
box. The Serial No. tab is displayed.

— Check box
Search conditions
Time | Fiename | Dsta Type | Keyworss | sersino. |
[rime Mot Mo:2
) ’V 014123458 ‘ ’V 014234567 ‘
I:‘ File Mame
M3 Mo:4
|:| Data Type ’V ‘ ’V ‘
D Keywords
v iserial No. »
Searchsubtolders. | Search | Search within results |

L Click to the right of each item to change the tabs on the right.

4. Enter a serial number.

Serial number specification allows you to search for data files of the specified instrument
serial number.

Note

« DAQLOGGER, AddMulti, and AddTrigger do not have serial numbers, and therefore data
acquired by those programs cannot be searched for using this criterion.
« Enter the serial number carefully as only exact matches will be found.

IM WX201-01E
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2.3 Specifying Search Conditions

Specifying Search Conditions

Explanation

Specifying Multiple Search Conditions

You can apply multiple or even all entered search conditions to the same search,
including date and/or time, file name, data type, keyword, and serial number.

As in the figure below, the major search categories are combined in an AND
relationship, and the conditions within each category are applied in an OR relationship.
When specifying search items, for example date/time and data type, files with data
from the specified date/time and of the specified data type are found.

When specifying search conditions within a tab, for example two or more data types,
files of any of the specified type are found.

Search conditions

Time | File Mame | Data Type | Heywords | Serial No.

IYTYTYYYYYYN B
Time

[x]

e®00cccccccccccccccccce,
[l
[=]
@
&
&
=
=
@

DAGLOGGER Acdohduti
[ s Trigger [ w00
[100/200 [ vt ooeo0
[ ex1o00:2000 [ Fton

D File Mame

I:‘ Heywords

Serial Mo

.
.
.
.
.
.
.
.
.
.
.
°

| Search subfolders. | Search | Search within resuts |

I

I

AND relationship OR relationship

Searching Subfolders

If you select Search subfolders, any subfolders existing in the registered search paths
are included in the search. If Search subfolders is not selected, any subfolders within
the primary search folders are not included.

If Search Subfolders is Cleared If Search Subfolders is Selected
« Searches only the files within the specified « Searches the subfiles within the specified
folder folder
 Data files (1) to (9) are not searched « All data files (1) to (9) are searched
DataFolder Specified search folder
Folderl 1)
—™1 AddMulti )

—1 AddTrigger~——— (3)
{1 DAQLOGGER @)
Folder2 (5)
—1 cx (6)
—1 bx )
1 mv ®)
—1 mx ©)

Note

The maximum allowable length for a path is 255 characters including the file name.

2-10
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2.4  Executing the Search

Procedure

Explanation

1. Specify search folders and search conditions. (See sections 2.2 and 2.3)
2. Click the Search button in the Search conditions area. (Select the Search
subfolders check box if necessary.

[#] search subfaiders. | Search | Search within resuts ]

The Search status dialog box appears.

Host Mame Folder ID Status Status

Errar
1 CPCO01-13666-01 Falder0 Finizhed 2957401 o
2 CPCO01-13666-01 Falderon2 Finizhed A o
3 CPCO01-13666-01 Falder003 Finizhed 36737 o
4 CPCO01-13666-01 Faldero04 Finizhed 0429 o
5 CPCO01-05713-02 Falder-B002 Failure os0 x

Click to view contents of the errorJ

Total 335 1474

Error  |E4946 : Connection failure. | | Close |

Changes to the Close button when the serach stop.

When searching |

Host Name
Displays the name of the host containing the specified search folder.

Folder ID
Displays the folder ID of the specified search folder.

Status (left)
Displays the search status.
Starting — Searching — Receiving data in progress ...% — Finished
Error: An error occured during the search.
Stop: Press to stop the search.
Status (right)
Displays the results of the search. The number to the left of the slash indicates the
number of files that matched the criteria, and the number to the right represents the
total number of files searched. The number of files that can be searched from a single
registered folder ID is sixty thousand. Once that limit is reached, the search stops.
Error button
If an error occurs, the button becomes “ 3 ” You can click the Error button to display
the contents of the error message.

Error
Displays the error number and message.

Total
Displays the total number of files found and searched.

Stop button
Stops the search. Once a search is stopped, the results obtained in progress are
displayed.

Close button
Closes the Search status dialog box. When the search stops, the Stop button changes
to the Close button.

IM WX201-01E
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2.5 Displaying Search Results

Displaying the Search Status
Procedure

1. When aregistered folder is searched with specified conditions, the search results
are displayed in the Search results area.

Registering Search Folders (section 2.2), Specifying Search Conditions (section
2.3), Executing the Search (section 2.4)

Display last page

Display previous page
Display first page—”

’7 Display next page
I

[ Searchresuts — || ] [ File Details
4 M Host Mame[Folder D] CPCOD1-13666-01 [ Folder0D1 |
W Channels 24
File Name:  Fils Mame DA GORK DataBrowsersts 0AGLOGGER-20000103-0008 mid =)
DA GLOGGER-200001 03-0008 mid
DAGLOGGER-20000103-0007 mid Elma +F
70315210005 Ho A Channel Interval[sec] Sizelsamples] Serial No Start Time Efa
70316350005 {0001 ] TAGO 1.000s8c 400 2000M01/0314:5301 000 20000
20317360005 [0002] TAGOND2 1000880 400 2000001/0314:5301 000 200001
20717490005 [0003] TAGONOS 1000580 400 2000/01/03 145301000 2000/
0718120 DEV [0004] TAGONO4 1.000s2c 400 2000001/03 14,5301 000 20000
20806120 DEY ’ 10005 ] TAGONS 1.000sec 400 2000001/03 145301 000 20000
70813500005 [ 0006 ] TAGONOE 1.000sec 400 200000103 145301 000 20000
70813520 DEV {0007 TAGONOF 1.000s50 400 2000/01/03 145301 000 200001
70817250005 {0008 TAGONOS 1.000s8c 400 200000103 145301 000 200001
70817360 DEV {0003 ] TAGON0S 1.000s8c 400 2000/01/0314:5301 000 200001
20309400005 [oo10] TAGONO 1000880 400 2000001/0314:5301 000 200001
Z0309410.0EY 10011 ] TAGO011 1000580 400 2000/01/03 145301000 2000/
[0012] TAGONZ 1.000s2c 400 2000001/03 14,5301 000 20000
100131 TAGON 3 1.000sec 400 2000/01/03 14:5301 000 2000010 7|
24 [Lopn | swe | E
Resize button L Click a file in the search results area
| to display its details
[ Searchresutts r
File Name: Data Type Start Time End Time Titls Comment
D4GLOGGER-20000103-0006 mid DAGLOGGER  2000i01/0314:5301000 2000001103 14:53:40.000
DAGLOGGER-20000103-0007 mid DAGLOGGER  2000/01/0314:53:41.000  2000401/03 1504:19.000
10315210005 Dx100 2004H2031521:46.000 200461 2/03 16:01:26 000 X100 12ch Disp 1minfdiv
0316350005 Dx100 20044203 163505000 2004/ 2703 17:15:24 000 X100 12ch Disp 1minfdiv
20317360005 Dx100 200441203 17.36:00,000 2004/ 2/07 14:16:00 000 D100 12ch-th1 2ch Disp hidiv
20717490005 Dx100 200441207 174300000 2004/12/08 11:13.00 000 D100 12+1 2Disp30minidivEventE0s
20718120 DEY DX100 200441207 151200000 2004/1 2/08 05:11:00 000 D100 1241 2Disp30minidivEvents0s
70808120 DEY X100 20044208 051200000 2004¢12/08 11:13:00 000 D100 12+ 2Disp30minidivEvertE0s i
70813500005 X100 20044205135010000 20044 2/08 16:56:30 000 D100 12+1 2Disp SminidivEvert10s
20813520 DEY X100 20044205 135250000 200441 2/08 16:56:30 000 D100 12+1 2Disp SminidivEvert10s
20817250005 X100 20044205 17:2520.000 2004/ 2/09 05:55:00 000 X100 12+1 2Disp20minidivEvent30s
Z0817360.DEY Dx100 20044208 17:36:30.000 2004/ 2/09 08:55:00 000 X100 1241 2Disp20minidivEvent30s
Z0309400.005 Dx100 200441200 03.40:24.000 2004/ 2/09 11:10:46 000 D100 12412 Disp2minidiy Eventss
70903410.DEY Dx100 20041209 0341:25000  2004/12/0211:10:15 000 D100 12+12 Disp2miniciv Eventss
<gI'Iq11 i D nx100 AN4M 209 11 anoon 041 2019 17-0F 00 000 D3RO0 12412 Dig
214 open | Save

Explanation

Search Results Area
Displays any found files in a list. The list is located in the lower left part of the screen.

File Name: The names of the found files.

Data Type: The data type of the found files.

Start Time: The time of the first data in the found files.
End Time: The time of the last data in the found files.
Title: Any titles given to the found files.
Comment: Any comments included with the files.

Host Name[Folder ID]: The host name and folder ID of the found files.

Note

« Data files are listed in the order in which their hosts were registered.
« If multiple titles and comments exist, only the first title or comment is displayed.
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2.5 Displaying Search Results

Specifying Pages
One hundred search results are displayed on a single page. If several pages are
generated, you can access other pages by clicking the arrow buttons in the upper right
of the Search results area.

Open button
Opens previously saved search results files. (See section 2.6)

Save button
Saves the currently displayed search results. (See section 2.6)

Sort Function
You can sort the search results by various items. When you click a column title in the
search results display, the Sort Status dialog box appears, and the results are sorted
according to the information in that column.

Sorting

e 4%

| Cancel

If you click the Stop button during the sort, the items are restored to their original
order.
Resize button
¢ Clicking this button widens the search results area to its maximum width. Click the
Resize button again to restore the window to its original size.
e You can also drag the button to the right to size the window manually. (Unless the
area is already at its maximum width)

Narrowing the Search Results
Procedure

1. Specify search conditions.

2. Click the Search within results button in the Search conditions area.

Search subfolders. | Search Search within resutts ]

Explanation

The Search within results button allows you perform a search of the files found during the
previous search. This function allows you to do the following.

* When a large number of search results are obtained, you can find desired files by
applying new conditions and searching through those results.

« If you save the search results (see section 2.6), you can perform multiple, different
searches on those results. By combining the Save/Open functions with the Search
within results function, you can create a search results file that fits your particular
task.

Note

The Search within results function searches on-screen files, and does not perform
communication. Searching within results can be performed on the local data, but data from
files found on a network host cannot be displayed (see chapter 3). To display data, the network
hosts must be running DataBrowser.
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2.5 Displaying Search Results

Displaying File Details
1. Click afile in the search results area to display its details in the File Details area.

Click the tag display switching buttons to display
the channel, Tag No., or Tag comment.

[ File Details
W Host Name{Falder D] CPCO0| -13666-01 [ Folder0 ] Show the file information display
W Channels Y button —|
 File Name CADAWORXDataBrowseridatalD AGL OGGER-200001 03-0006 mid £l
Tag display——l@@ ]
SWitChing M. Add Channel Intervalzec] Size[samples] Serial Mo. Start Time
buttons [ 0001 ] TAGO0M 1.000zec 400 20000103 14:5301 000 2000001
[0002] TAGODO2 1.000zec 400 20000103 145301 000 200001
[ 0003 TAGODO3 1.000zc 400 20000103 145301000 200001
[0004] TAGOD04 1.000sec 400 20000103 14:5301 000 2000/01
[0005] TAGODOS 1.0003ec 400 20000103 14:5301 000 2000001
[ D006 ] TAGOD0G 1.000zec 400 20000103 145301 000 200001
[ 0007 TAGODO? 1.000zc 400 20000103 145301000 200001
[000%] TAGODOE 1.000sec 400 20000103 14:5301 000 2000/01
[0003] TAGO009 1.0003ec 400 20000103 14:5301 000 2000001
[0010] TAGOD10 1.000zec 400 20000103 145301 000 200001
[0011] TAGOD11 1.000zc 400 20000103 145301000 200001
[0012] TAGOD12 1.000sec 400 20000103 14:5301 000 2000/01
| [0013] TAGOD13 1.000zec 400 2000/01,03 14:53:01.000 20000140 7|
< B

Explanation

Host Name [Folder ID]
Displays the host name and folder ID.

Channels

Displays the number of channels in the current file.
File Name

Displays the path and file name of the current file.
No.

A number for the files in the list.
Add

A button for adding the item to the trend display. (See section 2.7)
Tag display switching buttons

Channel: Displays the channel numbers.

Tag No.: Displays the tag numbers.

Tag Comment: Displays the tag comments.
Interval [sec]

Displays the save interval for each channel.
Size [samples]

Displays the number of data for each channel.

Serial No.
Displays the serial number for each channel.

Start Time

Displays the time of the first data for each channel.
End Time

Displays the time of the last data for each channel.

Trigger Time
Displays the trigger time for each channel.
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2.5 Displaying Search Results

Note
Tag numbers and serial numbers are not displayed for the following data types.
Tag numbers CX1000/2000, DX100/200, MV100/200, FX100
Serial numbers DAQLOGGER, AddMulti, AddTrigger, MX100

Serial numbers are also not displayed for computation-only data from the MX100, and for data
saved by Viewer.

“Show the file information display” button

Click this button to display the Datafile Information dialog box for the found file.

Click to select a tab

atafile Informatic ol x|
Commert | MarkiMeszage | Batch Information | Group Mame
Title: ‘”r;;;a’r’k}h;le;saig; Comment | ‘
- \ oachmiomten |
Mo
i W Application
W Supervisor | Group hame 1
W M= -
W Bat W Groups 1
M Co No Group Mame
M Co o

Comment
Displays the comments (title and comment) for the selected data file. If no data
exists, nothing is displayed.

Mark/Message
Displays the number and text of marks for the selected data file. If no data exists,
nothing is displayed.

Batch Information
Displays the batch information (Application, Supervisor, Manager, Batch Name,
Comment User, Comment) for the selected data file. If no data exists, nothing is
displayed.

Group Name
Displays the number and names of groups for the selected data file. If no data
exists, nothing is displayed.

IM WX201-01E
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2.6 Adding Channels from Search Results to the
Trend Display Window

The following describes the procedure for adding channels from the search results to the

Trend display window.

Collectively Adding a Selected Range of Channels

Procedure

1. Select a file from the search results area to display its details. (See section 2.5)

2. Select a range of channels to add and click the Add channels to this trend
configuration button.

Add channels to this trend configuration

Click to select/clear ——

all channels

Drag to

select range

Adding Individual Channels

Procedure

button
Haa &
Mo. Acld Channel
[ 0o ] TAGOOM
[ 0002 ] TAGOO0Z
—  [0003] TAGOOO3
[ 0004 ] TAGOOO4
[ 0005 ] TAGOO0S
[ O00E ] TAGOO0G
[ 0007 ] TAGOOOT
[ 0008 | TAGOOOS
[ D] TAGOOOZ
— (00101 TAGOOD
[o011 ] TAGOO1
[o012] TAGOM 2
| [0013] TAGOOS
4

1. Select a file from the search results area to display its details. (See section 2.5)

2. Click the Add button next to the channel to add, or double-click its number.

|—Add button

Ea@@E 4
Mo, e Channel

[ 0001 ] i TAGO001
[ 0002 ] seeooz — Click the Add
[0003] TAGOOO3 buttons
[ o004 ] TAGO004
[ 0005 ] TAGOODS
[ 0006 ] TAGOO0G
[ o007 ] TAGO007
[ 0008 ] TAGOOOS
[0008] TAGOO04E
[oo10] TAGOO10
[0011] TAGOD11
[oo1z] TAGO02
[00131] TAGO013

[

Note

|— Double-click
E=E= -4
M. Al Channel
(000 ] TAGO001
[0002] TAGO00Z
[0003] TAGO003
[0004] TAGO004
[0005] TAGO00S
[0006] TAGO006
[0007] TAGO00T
[0008] TAGO00G
[0003] TAGO003
[0010] TAGOO10
[0011] TAGO011
[0012] TAGO012
[0013] TAGO013

[«

The Add buttons are hidden if the File Details area is scrolled to the right. In this case, you can
double-click the item or click the Add channels to this trend configuration button.
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2.7

Saving and Loading Search Settings and

Results
Saving Search Settings

Procedure

Explanation

1. Click [§d on the toolbar or choose File> Save search settings as from the menu
bar. The Save search settings dialog box appears.

= el

;||=— Delete button

File List |
Search settings file 3 Q- Update button
File: Mame Comment
1 @ Al b Search conditions_Fek-07-2005
2 @ DAQLOGGERD i Search conditions_Fek-03-2005
3 @ Do 00-01 clbac: Search conditions _Fek-07-2005
4 52? ~latest i Search conditions_Fek-07-200%)
Drag to change the column width
Search settings file icon

File: Mame | |
Comment | |

Save I Cancel

2. Enter a file name and comment and click the Save button.
The currently specified search folder and search conditions are saved.

File List
Displays the search settings file name and comments of the search settings saved on

the local host.

Delete button
Deletes the selected search settings file.

Update button
Updates the displayed search results file list.

File Name
Enter the name of the file you wish to save. (An extension is automatically added.)

Comment
Enter comments to be saved with the file. Up to 255 alphanumeric characters can be

entered.

Save button
Saves the settings file under the specified file name on the local host.

Note

After saving a search settings file, the saved file name and comment appears in the text box
the next time you open the Save search settings dialog box (these items are blank if no settings
have been saved previously, or when starting up the software). Also, when you select a file in
the Save search settings dialog box, the file and comment are displayed in the input boxes at
the bottom of the window. This allows you to conveniently overwrite settings.

IM WX201-01E
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2.7 Saving and Loading Search Settings and Results

Opening Search Settings from a Local Host

Procedure

1. Click @ on the toolbar or choose File> Open from the menu bar. The Open
dialog box is displayed.

Bt N IO pelete button
Local Host | Hosts on network |
File List Q- Update button
File hame Comment
1 @ Acddbuttind dbc Search conditions_Fek-07-2005
2 @ DAGLOGHERD dho Search conditiions_Fek-08-2005,
) @ Cx100-01 dbc Search conditiions_Fek-07-200/
4 g? ~latest.dbo Search conditions_Fek-07-2005
Drag to change the column width
Double-click a number to open the file
File Type |Search =ettings filel.dbc) ﬂ
Open Cancel ]

2. Select a file and click Open, or double-click the file number. The Information
dialog box opens.

4

M4951
@ Replace the current search settings with the selected settings?

3. Click the Yes button. The search paths and search conditions loaded from the
search settings file are displayed. Click No to close the Information dialog box.

Explanation

File List
Displays the name of the settings file and comments saved on the local host.

Delete button
Deletes the selected file.

Update button
Updates the displayed file list.
File Type
If you select all files (.dbc; .dbv), the saved search settings files and display settings
files are displayed.
If you select Search settings file (.dbc), only the search settings files are displayed.
If you select Trend settings file (.dbv), only the display settings files are displayed.
Open button
Opens the settings file selected in the File List. When a search settings file is opened,
the Search window becomes active. (When a trend settings file is opened, the Trend
display window becomes active.)

Cancel button
Closes the Open dialog box.
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2.7 Saving and Loading Search Settings and Results

Opening Search Settings from a Network Host

Procedure

Explanation

Click [ on the toolbar or choose File> Open from the menu bar. The Open
dialog box is displayed.

Click the Hosts on network tab. The Hosts on network tab is displayed.

Click the Update button. The names of hosts running DataBrowser, and their
corresponding files names and comments are displayed.

Host List Q- — Update button
Host Mame

1 CPCODM-05713-02

Double-click a number to open the file

it |— Drag to change the column width
|

Host Mame  CPCO01-05713-02

| File Marme Comment
1 @ CH1000_B00 dbc SeachSettingB_Feb-03-2005
2 F DAGLOGGER_BO01 dhc SeachSetting®_Feb-03-2005
File Type |Search settings filel dbc) j

| Open | Cancel l

Select a host from the Host List. The a list of files saved on the selected host is
displayed.

Select a file from the list that you wish to load and click Open, or double-click the
file number. The Information dialog box opens.

4

M4951
@ Replace the current search settings with the selected settings?

Click the Yes button. The search paths and search conditions loaded from the
search settings file are displayed. Click No to close the Information dialog box.

Host List
The Host List displays the names of any hosts on the network that are running

DataBrowser. Up to two hundred hosts can be displayed.

File List
Displays the settings files and comments saved on the host selected in the host list.

Host Name
Displays the name of the host selected in the host list.

Update button
Updates the host list and file list.

File Type, Open Button, and Cancel Button
See Opening Search Settings from a Local Host.

IM WX201-01E
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2.7 Saving and Loading Search Settings and Results

Saving Search Results

Procedure

Explanation

1. Click the Save button in Search results area or choose File> Save the search
results as from the menu bar. The Save dialog box appears.

(ml
: =IO pejete button
File List |
Seach resutts file B O -— Update button
File Mame Comment

1 Addbdulti- 001 SearchResults_Feb-08-2005

2 AddTriggeri-4001 SearchResults_Feb-08-2005

3 DAGLOGGER-A001 SearchResults_Feb-08-2005

4 mx100-2001 SearchResults_Feb-05-2005

Drag to change the column width
File Mame | |
Commert | |
| Save || Cancel |

2. Enter a file name and comment and click the Save button.

The displayed search results are saved.

File List
Displays the name of the search results file and comments saved on the local host.
Delete button
Deletes the selected search results file.
Update button
Updates the displayed search results file.
File Name
Enter the name of the file you wish to save. (An extension is automatically added.)
Comment
Enter comments to be saved with the file. Up to 255 alphanumeric characters can be
entered.
Save button
Saves the search results file under the specified file name on the local host.
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2.7 Saving and Loading Search Settings and Results

Opening Search Results from a Local Host

Procedure

1. Click the Open button in Search results area or choose File> Open the search
results from the menu bar. The Open dialog box is displayed.

=Pl pelete button

Local Host | Hosts on network |

File List B O -—Update button
File Mame Comment
1 Addbutti-2001 SearchResults_Feb-03-2005
2 AddTriggeri-&001 SearchResults_Feb-03-2005
3 DAGLOGGER-4001 SearchResutts_Feb-03-20035
4 D¥100-4001 SearchResults_Feh-03-2005
5 MX100-A001 SearchResults_Feb-03-2005

Drag to change the column width

Double-click a number to open the file

|__ Open _H__Canc:el |

2. Select a file and click Open, or double-click the file number. The Information
dialog box opens.

A

M4953
Replace the current search result with the selected result?

3. Click the Yes button. The search results loaded from the search results file are
displayed. Click No to close the Information dialog box.

Explanation

File List
Displays the name of the search results file and comments saved on the local host.

Delete button

Deletes the selected file.
Update button

Updates the displayed file list.

Open button
Opens the search results file selected in the File List.

Cancel button
Closes the Open dialog box.

IM WX201-01E 2-21

MOPUIA Yo1eas ereq ay) Jo uonelado ﬂ



2.7 Saving and Loading Search Settings and Results

Opening Search Results from a Network Host

Procedure

Explanation

Click the Open button in Search results area or choose File> Open the search
results from the menu bar. The Open dialog box is displayed.

Click the Hosts on network tab. The Hosts on network tab is displayed.

Click the Update button. The names of hosts running DataBrowser, and their
corresponding files names and comments are displayed.

=10l |

Host List {3 7— Update button
Host hame

1 CPCODM-05713-02

Double-click a number to open the file

Drag to change the column width
F{le List |7

Flost Mame CPCO01-05713-02

File Matme Commert A
1 CX1000-B001 SearchResults_Feb-04-2005
2 Fx100-B001 SearchResults_Feb-04-2005
3 MX100-B001 SearchResults_Feb-04-2005 7|

Il Open J|_Cancel |

Select a host from the Host List. The a list of files saved on the selected host is
displayed.

Select a file from the list that you wish to load and click Open, or double-click the
file number. The Information dialog box opens.

zl

M4953
Replace the current search result with the selected result?

Click the Yes button. The search results loaded from the search results file are
displayed. Click No to close the Information dialog box.

Host List
The Host List displays the names of any hosts on the network that are running

DataBrowser. Up to two hundred hosts can be displayed.

File List
Displays the settings files and comments saved on the host selected in the host list.

Host Name
Displays the name of the host selected in the host list.

Update button
Updates the host list and file list.

Open Button and Cancel Button
See Opening Search Results Files from a Local Host.
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2.8 Copying Data Files

This section describes the procedure for copying a data file from a specified folder to
another folder.

Procedure

1. Click &g on the toolbar or choose File > Import Data Files from the menu bar.
The Import Data files dialog box opens.

= - Import Data files

Source ; . Select.. |

Destination :

2. Click the Select button for the Source. The Browse for Folders dialog box is

displayed.
2
&: \DACWORK AddMulti
E‘E—G‘ 34 Floppy (&:) ;I
¢ B0 DagwioRs
T

-7 addobserver Runtime

[ addobserver

-] addTrigger

- DAGEERIUs

-1 DaGEEPus Clienk

-] DAQEAPLORER

D DAQLOGGEER

-7 DAQLOGGER Client =l

Mew Falder... | o]4 I Cancel |

3. Select a source folder and click the OK button. The Import Data files dialog box
reappears.

4. Asin step 2, click the Select button for the Destination. The Browse for Folders
dialog box is displayed.

Dihirano) DADWORK Trend_Data

(] DAQLOGGER. Client |
(] DataBrowser

-] GateCONTROL

(] GateDwp

(] GateEye

-] GateMODBUS

(] GateMx100

(] GatewT J

(0] MHLOGGER

-] DataBrowser LI

Mew Folder... | oK | Cancel |

If you do not want to create a new folder, skip to step 7.
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2.8 Copying Data Files

Explanation

5. Select a location in which to create a new folder, and click the New Folder button.
The Create New Folder dialog box is displayed.

Create Mew Folder ) i x|

Enter a name for the new falder that you want to create.

— Current Folder

CADADWORMIDataBrowserdatalTrend_Data

—~Mew Folder Mame

Ok I Cancel |

6. Enter the name of the folder to be created, and click the OK button. The Browse
Folders dialog box is displayed (the screen in step 4).

7. Select the destination folder and click the OK button. The Import Data files dialog
box reappears.

= ~Import Data files

Source 2D ACAAORXA deibultit Select...

Destination ;. C\DataBroveseridstanTrend _Datanadabiutti-001 4 ! Select... !

| stat || close |

8. Click the Start button. When copying is complete, “Completed”is displayed in the
bottom of the Import Data files dialog box along with the number of copied files.

e -~ Import Data files

Source ; 2D AR deihduti, Select...

Destingtion :  C\\DataBroveseridatalTrend_DatatAddhiulti-001 1 ! S

Completed{Mumber of Imported files. 8)

The Import Data files function allows you to copy data files saved on the floppy disk or
CF card of a recorder to a specified folder. By specifying a copy source and destination
the first time you import files, subsequent imports can be done quickly and easily.

Note

Only folders on the local host can be specified as the source and destination folders.

Select Buttons (Import Data files Dialog Box)
A folder for specifying folders is displayed.
New Folder (Browse Folders Dialog Box)
Lets you create a new folder in a specified location. The Create New Folder dialog box
is displayed.
Start Button (Import Data files Dialog Box)
Executes the import of data files. This button is not active unless a source and
destination folder are selected.
Stop Button (Import Data files Dialog Box)
Becomes available once importing has started. Stops the importing of data files.
Close Button (Import Data files Dialog Box)
Closes the Import Data files dialog box.
OK Button (Create New Folder Dialog Box)
Creates the new folder.
Cancel Button (Create New Folder Dialog Box)
Cancels creation of the new folder and closes the Browse Folders dialog box.
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Chapter 3  Operation of the Trend Display Window

3.1 Names of Parts in the Trend Display Window

The Trend display window consists of the display channel settings screen and the
waveform display screen.

Opening the Trend Display Window

Procedure

1. Click ﬂ on the toolbar or choose View> Trend display from the menu bar. The
Trend display window opens.

Display Channel Setting Screen
The display channel setting screen can display the channel information screen, or the
channel display configure screen, each of which contain channels added from the search
results.

Channel Information Screen

Display Channel Setting Screen Toolbar

Menu bar Toolbar Display Channel Setting Screen groups toolbar
Trend display ~ edooniie] | -I— =10l x|
& [File  View ‘Window Help =l x|

IEEEF T IR

fead 25 Rl R P P P T Hn B
ol i
Group Mame  [Groupot ] B &=
Mo Channel Start Time: Endl Time: Trigger Time Interval[=ec]
Wi TAGOO01 2000/01 /03 14:28:35.000 2000i01/03 14:29:05 000 2000i01/0% 14:25:35.000 1.000
W2 TAGOO02 2000/01 /03 14:29:35.000 2000i01/03 14:30:05 000 2000i01/0%5 14:29:35.000 1.000
W03 TAGOO03 2000/01 /03 14:30:35.000 2000i01/03 14:31:05 000 2000i01/0%5 14:30:35.000 1.000
W4 TAGOOD4 2000/01/03 14:31:35.000 2000i01/03 14:32:05 000 2000i01/0%5 14:31:35.000 1.000
WOS 00001 2000/01/03 14:26:55 700 2000i01/03 14:25.14 300 2000i01/0%5 14:27.20.700 0100
WO 00002 2000/01/03 14:26:55 700 2000i01/03 14:25.14 300 2000i01/0%5 14:27.20.700 0100
WOF 00003 2000/01/03 14:26:55 700 2000i01/03 14:25.14 300 2000i01/0%5 14:27.20.700 0100
W03 00004 2000/01/03 14:26:55 700 2000i01/03 14:25.14 300 2000i01/0%5 14:27.20.700 0100
4 -
Ready A

Channel Display Configure Screen

=10l x|
=181x|
i < [ < [ P %2 P %P B i [ i B [ L
oo
Group Name [GraupD1 | BE
: Scale Zone - =
L F
Ho. Channel Yobixis  Fom i i T Trip 1 Trip 2 Colar
[ v TAGO001 = Linearq] 2000 200.0 0 100 ¢ 2000 2000 [N
& Wiz TAGO002 &= Linearq -60.00 60.00 o 100 5000 50.00 [
[ W03 TAGOD03 = Linear] -2.000 2,000 o 100 2,000 2,000
[ W4 TAGOD0 = Linear] 2000 200.0 o 100 2000 200.0
[ A0S 00001 = Linear] -2.0000 2.0000 o 100 2.0000 20000
[ woB 00002 = Linear] -2.0000 2.0000 o 100 2.0000 20000
[ wn7 00003 &= Linearq -2.0000 2.0000 o 100 20000 zo000 [0
[ W08 00004 & Linearq] -2.0000 2.0000 o 100 2.0000 20000 |00
= (23N 8 1 T £ T B ] s (] "
k| 3 |k |k 3 3 x 3 E
Feady A
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3.1 Names of Parts in the Trend Display Window

Explanation

Group Name
You can specify a group name using up to thirty alphanumeric characters.
No.
Number assigned within groups.
Channel, Tag Number, and Tag Comment
Displays identifiers for the channels (display can be switched using the group tab tool
bar).
Start Time
Time of the first data.

End Time
Time of the last data.
Trigger Time
Time of the trigger point (if no trigger point exists, the first data is used.)

Interval [sec]
The save interval for the data.

Data Size
The number of saved data.
Data Type
The instrument or software that saved the data.
File Name
Name of the file to which the channel belongs.
Host Name
Name of the host on which the channel to which the file belongs resides.
Toolbar
R 1A

L |— Displays version information.
Displays the Trend display window.
Displays the Search window.
Copies data files
Saves Trend settings files

Opens Trend settings files
—Opens new Trend Display window.
—Opens new Search window.

Display Channel Setting Screen Toolbar (for Channel Info and Configure
Screens)

b2 El@ @ P P P WP By
L IL IL

LLLLE

Linked | i L Displays channel details.
inked group setting
Moves groups
(OFF 1,2,3,4) (forward, backward)
Switches between Channel, Adds/deletes groups
Tag No., and Tag Comment Copy/Paste

Opens the trend display screen.
'—Opens the channel setup screen.

Display Channel Setting Screen Group Tab Toolbar
&

L I: Moves channels (up and down)
Deletes channels

Displays channel display configuration
Displays channel information
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3.1 Names of Parts in the Trend Display Window

Editing Functions in the Channel Display Configure Screen

Copy
Click to select all IIDaste
B EwEl®® % P & 6 @ 6 6
01
Gre|ip Mame  [Groupol | (]
Charinel Yobxis  Fom. . Sl o MinzmeMax Trip 1
[ W1 TAGO001 Linearﬂ -200.0 200.0 o 100 ™ 2000
[ W02 TAGO002 Linearﬂ -60.00 £0.00 1] 100 ™ 60.00 3
[ W03 TAGO003 Linearﬂ -2.000 2.000 1] 100 ™ 2.000
[~ 7 TAG0004 Linearﬂ -200.0 200.0 1] 100 ™ 2000
[ Wos{00001 Linearﬂ -2.0000 2.0000 1] 100 ™ 2.0000 O
[ WOB[00002 Drag to seIeCt a range Linearﬂ -2.0000 2.0000 1] 100 ™ 2.0000 o
] :::|.' 00003 Linear 4] -2.0000 20000 0 100 2.0000 @
[ W& 00004 Linear 4] -2.0000 2.0000 o 100 2.0000 )
<
3 o 3 : EE 1 " S
T L [ IT = 1kl [ 1 [ I\ [ o
I | | iy
Click to select for Click this button to Click this button to setall ~ Click this button a
Copying/Pasting. turn all select buttons to the same as the top of  to reset to default =
The flaf is display. ON/OFF collectively the selection 3
]
o
Copy g
. . [%2]
Copies the selected range to the clipboard. o
Q
Paste <
Pastes copied contents to the displayed group. If a range is selected, pastes the §
contents into that range. If a range is not selected, the contents are added at the )
=

bottom.
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3.1 Names of Parts in the Trend Display Window

Waveform Display Screen

Displays the waveforms of the channels in the channel information screen.

Menu bar Toolbar

N ~ioi

Waveform Display Screen Toolbar

=18 x|

PODFE@RRHE Y A RS QG O MBIy =FEE S|

Groupd1 ‘ Group02 | Groupad ‘ Groupdd |

Waveform Display Screen Toolbar

e ]

Linked group settings
(OFF, 1, 2, 3, 4)

Switches between Channel,
Tag No., and Tag Comment

— Copy
— Opens the trend display screens
'—Opens the channel setup screens

Switches the time reference mode
(Start, Trigger, End, Time)
Select all
Delete cursors
Shows/hides alarms

—Reacquires channel data

RE A O L KM & < EE g

Switches between
absolute time/Relative time

Zoom in and out, display all,
specify factor

Switches the trend display ———

L |—Shows channel details
Displays conversion settings

Displays computed results
(statistcs)

Displays the cursor values
Clip

'—Scale calculation

(User zone, Edit zone, Full zone, Side zone, Auto zone, Multi-zone)

3-4
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3.2 Selecting a Group for Adding Channels

Channels can be assigned to groups in the channel display configure screen. Up to fifty
groups can be created, each with up to thirty-two channels. When channels are added in
the Search window (see section 2.6) they are added to the selected groups.

Adding and Deleting Groups
Clicking the button in either of the channel setup screens adds a new group tab on
the end of any existing tabs.

Clicking the button in either of the channel setup screens deletes the currently
displayed group tab.

Linked Group Settings

This function links cursor positions and time reference modes across groups in the trend
display screen. The available settings are Link OFF, Link 1, Link 2, 3, and 4. You can
select either from any group. Groups with the same link number are called linked groups,
and up to four linked groups can be set.

Select a group, then select one of the options

0 (55 [EE] @5
— I G ) - e F—— -
W | Wy o3| 04 |Pos | BPos|To7| 08 (Wog| o (g | 9
| Group Name [ Groupdz | B
Mo. Channel Yofxiz  Fom.

[ Wu0q CHOM & Linear]

[ W02 CHO2 & Linear]

[ W03 CHOM & Linear]

3 wnand ~UnA R —
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3.3

Settings in the Channel Setup Screens

You can edit display settings by following the indications in the figure below.

Swich between the display channel settings screen

and waveform display screen

Set linked groups (OFF, 1, 2, 3, 4)

Add/delete/move forward/backward groups

dba cisley —Trona-pomtab] || =0 x]
Winejow  Help _I_I- = 1'
=l |
- 56 ([ & [ B)Z)— Display channel details:
((m [ 2] | ¢« —Switch the displayed group
Froup Name |Gruup04 | @@
Channel Start Time End Titne: Trigger Time Irterval[zec
200401 2103 15:21:46.000 200441 2103 16:01:26.000 20044 2103 16:01:26.000 2.000 :
200401 2103 15:21:46.000 200441 2103 16:01:26 000 200442103 16: 2.000 I
| 200401 2108 13:50:10.000 200441 2105 16:56:30.000 10,000 I
Select channels Switch between the channel Information and
Select/clear all channels channel display configure screens

-~ [Trend display - Trend=8000ab] Y _ ol =l
B File View Yindow Help =& %]

BR sH % HE S ?

] 2 ] o [ 0B 2 2 @ = Delete channels or move them (up and down)
o | o2 | o3 | o4 |
Group Name |Gruup04 | @[@ ]

Channel

Y-Axiz  Fom

000000

-

Trip 1

2.000 1
2.000
2.000
1.000
1.000
1.000
1.000

8 < Himm - i Y

[~]

—

Trip 2

-2.000
-2.000
-2.000
-1.000
-1.000
-1.000
-1.000

Color

— Select channels
'— Turn waveforms ON/OFF

Turns the Y-axis ON/OFF—
when in multi-zone display

Explanation

Specify a waveform—
display zone

'— Select a scale value display
format (floating point or exponeial)

.3

V. . )
Turn trip point
ON/OF

Select Y-axis type (linear or logarithmic)

Display/Hide Channels
By selecting and clearing the check buttons in the No. column on the channel display

configure screen, you can select whether to display those channels”data in the Trend
display screen.
Channel (Tag Number and Tag Comment): Can be selected/deselected for

display.

The Channel column displays the channel, tag number, and tag comment.
Display/Hide Y-Axis and Type
By selecting and clearing the check buttons in the Y-axis column, you can select
whether to display the Y-axes of the corresponding channels in the Trend display

screen. This setting is only valid if multiple zones are specified in the Trend display

screen.

Channel display
color
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3.3 Settings in the Channel Setup Screens

Minimum and Maximum Values of Scale, and the indstart Scale Value
Display Format instop
You can set the maximum and minimum values of the scale when displaying waveforms.
The value in the Scale Min column is the lower end of the Y-axis, and that of the Scale
Max column is the upper end.
In the Form. column, you can specify floating point or exponential format for the scale

values.
Selects exponential display Waveform Display Screen
Scale
Folm.
Min kS
-2 D00ED 2 D00ED ———
-2.000 2000

Setting the Waveform Display Zones
You can set waveform display range for displaying trends. The waveform display
range is set as 0% at the bottom, and 100% at the top. The values in the Zone Min
and Max columns represent the lower (0-9%) and upper (1-100%) ends of the trend
display range.

Waveform Display Screen

Fone
hdlir L Ew
25 75
0 100

Setting Trip Points
You can display a trip line to indicate a particular value of interest (trip point) in the

trend display area. Two trip points (trip 1 is red, trip 2 is blue) can be set for each
waveform. By selecting and clearing the check buttons in the Trip 1 and Trip 2
columns, you can select whether to display the corresponding trip points in the Trend
display screen.

Trip 1 value Trip 2 value Waveform Display Screen

Trip 1 Trip 2
1.50C -1.500
r 2000/ -2.000

Trip line ON/OFF

Mmopulp Aejdsig puail ayl jo uolelsado H
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3.3 Settings in the Channel Setup Screens

Channel Display Colors

You can assign colors to channels displayed in the trend display screen. Click the

colored part to open the Color Settings dialog box.

Basic colors:

Diefine Custorn Colars > |

Ok I Cancel |

Showing Channel Details

You can view detailed information about a channel selected in the channel setup

screens.

« Click [ZZ4 in the channel setup screen toolbar. The Channel Information dialog box

opens.

Trigger Time 200(101 03 14:25:56.1 00
Interval[zec] oo

Data Size F00p

Serial Mo. 12CE0291 7

Data Type ff|00

File Mame Xl OGGER-0103-1425.mfdd

Path Mame COC|AChYORXDataBirows rdataihd =100
Host Mame CPC|001 -1 3666-01

Information Tab

B Channel Infarmation P[] 74

Group NHame Group03 Name of currently displayed group
Ha. Vi Number assigned within groups
Channel CHOO001 Channel

Tag Mo. MALOG 01 Tag number :|Channel identifiers
Tag Comment MHLOGEER 01 Tag comment
Unit W - Units

Information I Commert Infarmation ” Batch Information

ftem Conte[its
Start Time 200101 103 14:25:56.100
End Time: 200101 103 14:30:56.900

Displays the batch informaition page
Displays the comment information page

Displays the start time, end time, trigger time*, interval (sec), data size, data type, file

name, path name, and host name.

* (If the data has no trigger point, the first data is used.)

Comment Information Tab

Displays the title and tag comment. Displays all comments. The item is blank if the

data contains no comments.
Batch Information Tab

Displays the batch information. The items are blank if the data contains no batch
information. The displayed items are application, supervisor, manager, batch
name, lot number, comment user, comment time, and comments 1 through 3 (for
details, see the user’s manual of the instrument that saved the batch information.)

3-8
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3.4 Displaying Trends

Displays waveforms according to the settings in the channel setup screens.

Procedure

1. Click the Show the trend display button in either of the channel setup screens.
The channels selected in the tab are loaded. While loading, the “Receiving”dialog -

box is displayed, and when complete, the waveforms appear (click the Cancel
button to stop the loading process. Only the waveforms of channels completely
loaded at the point the Cancel button was clicked are displayed. To load the
remaining waveforms, click the “Get data for all channels”button).

Receiveing

Host: [ 1/ 1]CPCO01-13666-01
File [ 2r 3]Z0812500.008
Channel: [ 0f 4]CHOZ

Cancel

Waveform display Reacquire channel data button

button Sl Hea@reeen S@KMEY ¥ ¥ QQEQ® WK Il MEY S TEH S8

Group —— roul | oL | rou| i Trlp pOInt
selecrt)ion —_ == == Mark display area display area-
tab

Zone size
bar

Grid color —

adjusutment
slider

Mmopuip Aejdsi@g puail ayl jo uolelsado

Y-axis button — g

Active Y-axis—

mark
Background— ]
adjustment
slider
Zone display —— : |
area
Show/hide Zone display bar Time axis display Alarm display Time axis
waveform button area area magnification
Note

If some channels are not displayed, check the following.

e That the host exists, and that it is running DataBrowser.

e That the files shown under File Name in the folder indicated by the path in the Channel
Information dialog box exist.

* That the network is connected correctly, and that no problems occurred on the network.
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3.4 Displaying Trends

Explanation

Group Selection Tabs
Click a tab to display the group. The name displayed is the one specified in the

channel setup screen.

Waveform Display Area
The area in which the waveforms are displayed. Displays waveforms according to the
settings in the channel setup screens. Click in the waveform display area to display a
cursor. Drag the cursor to display a second cursor. Cursor A appears at the position
where you first clicked; Cursor B appears at the position where you released the
mouse button. (See section 3.5, “Displaying Cursor Values.”)

Alarm Display Area
The area in which the alarms are displayed. Toggle the display using the Alarm ON/
OFF button on the toolbar.

Y-Axis Display Area
The area in which the Y-axes are displayed. The Y-axes are shown in the specified
colors. If the trend display is user zone, edit zone, full zone, or slide zone, only the
Y-axis of the active channel is displayed. For auto zone or multi-zone, all channels
are displayed.

Time Axis Display Area
The area in which the time axis is displayed. You can select the display range using
the scroll bar.
Toggle the display between absolute time and relative time display using the button on
the toolbar.

010000

Relative Time [DAY him:s]

Zone Display Area
The area in which the display status of each channel can be changed.
Active Y-Axis Mark
The channel with this mark is the active channel. The waveform and alarm data of
the active channel are displayed in front.
Grid Color Adjustment Slider
Drag the slider up and down to adjust the grid color between white and black.
Background Adjustment Slider
Drag the slider up and down to adjust the background color between white and
black.
Y-axis button
Each channel has its own color-coded button. Click a button to make its channel
active. The active Y-axis mark moves to the top of the clicked button.
Zone Display Bar
Click to show or hide the zone display area.
Zone Size Bar
Drag to change the width of the zone display area.
Show/Hide Waveform Buttons
Click to show or hide channels. These buttons mirror the waveform display ON/
OFF buttons in the channel display configuration screen.
Trip Point Display Area
Displays trip points.
Mark Display Area
Displays marks. All marks of the channels registered to the displayed groups are
displayed. Up to one thousand marks per channel can be displayed, and they can be
added, edited, or deleted here. When marks are displayed on top of one another, the
mark of the active channel is displayed in front.

3-10
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3.4 Displaying Trends

Time Axis Display Area
e The time display shows the time of the channel. When the time reference mode

is Start Reference, Trigger Reference, or End Reference, the time of the active
channel is displayed.
¢ The time display shows the time relative to the start of the waveform display area.

Showing Channel Details
In the Trend display screen, the information of the active channel is displayed.

Displaying Waveforms of Different Intervals

Data of differing measurement intervals can be displayed in the same waveform display

screen.

Measurement Interval of Displayed Waveforms
When the measurement intervals differ, the greatest common factor of the
measurement intervals of the channels assigned to the displayed groups is used as
the minimum interval unit for displaying all of the waveforms. In the figure below,
since the intervals for the three channels are 1 s, 500 ms, and 250 ms respectively,
250 ms is used as the interval when all channels are displayed together.

s M
500ms W

3
7, .

%

250ms
i Lo
i b
Greatest P
common
factor

Displaying Waveforms of Intervals Greater Than the Minimum Unit
If a channel’s interval is longer than the minimum unit interval, data values that are not

measured points are displayed at the value of the points directly thereafter.
Measured point

Minimum unit interval waveform£ = o o
o © o o o

Longer than the minimum unit /:\:9/ o ,
- ————— Same value
interval waveform Same value Same value
Same value
Measured point Measured point

Minimum unit display interval

The figure below shows a 100 ms and 1 s interval waveform. The waveform with the
long interval is displayed in stages.

Minimum Unit Interval for Linked Groups
The greatest common factor of the measurement interval of all channels registered to

all groups belonging to the linked group is used as the minimum unit interval.

IM WX201-01E 3-11
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3.4 Displaying Trends

Time Reference Mode

There are four time reference modes: Start Reference, Trigger Reference, End

Reference, and Time Reference.

Start Reference
Waveforms are displayed using the first data of the channels assigned to the group as
a reference.

Trigger Reference
Waveforms are displayed using the trigger point of the channels assigned to the group
as a reference.

End Reference
Waveforms are displayed using the last data of the channels assigned to the group as
a reference.

Time Reference
Waveforms are displayed using the measurement time of the channels assigned to
the group as a reference.

Start reference Trigger reference
/-/\A/ e M
L\ S\ I
Time Time
End reference . Time reference
i Time Time

Save Format of Displayed Data

Data files are saved in two formats: one for waveform display and one for the cursor
value dialog box. Data saved in different formats can be displayed in the same Trend
display screen.

The format in which one data is saved per unit of time is called Normal format, and the
format in which two data—a minimum and maximum value—are saved per unit of time is
called MinMax format.

The following shows the correspondence between data types and save formats.

Data Type Normal Format MinMax Format
DX100 Yes Yes
MV100/MV200 Yes Yes
CX1000/CX2000 Yes Yes
FX100 Yes Yes
MX100 Yes No
DAQLOGGER Yes No
AddMulti Yes No
AddTrigger Yes No
Note

Instruments that can save in MinMax format such as the DX100/200, MV100/200,
CX1000/2000, and FX100 save data in two formats called Event data and Display data format.
Event data is saved in Normal format, and Display data is saved in MinMax format. For detalils,
see the user’s manual for your particular instrument.

3-12
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3.4 Displaying Trends

Waveform Display in Normal Format indstop and indstart MinMax Format
In Normal format, waveforms are displayed in the position corresponding to the data
value at that time.

In MinMax format, waveforms are displayed as a fill between the two points
corresponding to the Min and Max values at that time. When the Min and Max values
are the same, items are displayed as if in Normal format. If the difference between
the Min and Max values is large, the thickness of the trace increases.

Intersection between Waveform and Cursor
In Normal format, the intersection is marked with a circle.

In MinMax format, the two intersecting points of the Min and Max values are enclosed
by an ellipse.

Normal Format MinMax Format

Circle  Ellips

Maximum value
Minmum value

Displaying Alarms
You can show or hide the alarm display area using the Alarm ON/OFF button on the
toolbar. This operation mirrors the alarm ON/OFF operation in the Cursor Value dialog
box. Up to four alarm levels per channel are allowed. As shown in the figure below, the
alarm levels are 1, 2, 3, and 4, starting from the top level. The colors of channels on
which alarms occurred indicate the period of occurrence. If multiple alarms occur at the
same time, the alarm of the active channel is displayed in front.

Alarm level 1
Alarm level 2
Alarm level 3
Alarm level 4

Y-Axis Display
There are six formats for the Y-axis: user zone, edit zone, full zone, slide zone, auto zone
and multi-zone. You can switch between them using the toolbar.
User Zone
The waveform of each channel is displayed in the position specified under Zone in the
channel display configure screen. A single Y-axis of the active waveform is displayed.

Active Y-axis mark Displays the Y-axis of

the active channel

Click a Y-axis of
the active channel

IM WX201-01E 3-13

Mmopulp Aejdsig puail ayl jo uolelsado H



3.4 Displaying Trends

Edit Zone
The waveform of each channel is displayed in the position specified under Zone in the
Channel Display Configuration Screen. You can edit the waveform display range by
manipulating the Y-axis buttons in the zone display area. Move the waveform position
by dragging the Y-axis button up and down. The waveform zone settings implemented
here are reflected in the Zone setting in the Channel display configuration screen, as
well as the user zone and multi-zone settings. A single Y-axis of the active waveform
is displayed.

Active Y-axis mar

Displays the Y-axis of

Drag the knob to the active channel

change the
minimum/maximum
value of the zones
individually

By dragging the zone
you can change its
position without
changeing the range

Full Zone
Displays all the waveforms over the full zone of the waveform display area regardless
of the Zone settings on the Channel display configuration screen. A single Y-axis of
the active waveform is displayed.

Active Y-axis mark—I

Slide Zone
Displays the waveforms by slightly offsetting the display position of each waveform
vertically regardless of the Zone settings in the Channel display configuration screen.
A single Y-axis of the active waveform is displayed.

Active Y-axis marﬂ»

3-14 IM WX201-01E
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Displays the Y-axis of
the active channel

The waveform of each channel are
offset in this manner




3.4 Displaying Trends

Clip Function

Auto Zone
Displays the waveforms by dividing the waveform display area evenly according to

the number of displayed waveforms regardless of the Zone settings in the Channel
display configuration screen.

Active Y-axis mar

Automatically displays
the waveformin equal divisions

Multi-Zone
Arranges all the Y-axes from left to right, displaying all specified Y-axes. Y-axes not

selected in the Channel display configuration screen are not displayed. The display
range is set using the Zone parameter in the Channel display configuration screen.
When you drag a Y-axis button onto the Y-axis display area, the Y-axis of the relevant
channel is displayed. Conversely, if you drag a Y-axis onto the zone display area, the
Y-axis of the relevant channel is hidden.

Drag the Y-axis button of the Y-axis that is

not displayed onto the Y-axis display area
to display it again

Active Y-axis mark

The Y-axis of the active
channel is displayed on
the far right

If you drag the Y-axis display onto
the zone display area, the Y-axis is hidden

Turning ON the clip function forces displayed points on the waveform that fall outside of
the scale range to revert to the max. or min. value of scale. Use the Clip button on the
toolbar to turn the clip function ON and OFF.

Clip OFF (initial setting) Clip ON

IM WX201-01E
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3.4 Displaying Trends

Trip Point
The trip points are displayed according to the Trip 1 and Trip 2 settings in the Channel
display configuration screen. You can drag the trip 1 and trip 2 displays to change
them. These changes are reflected in the Trip 1 and Trip 2 items in the Channel display
configuration screen.

You can change the trip point by dragging

Copying the Trend Display
Clicking the XX button (copy button) in the Trend display toolbar copies the displayed
trend screen. You can paste the copied screen onto a standard “Paint’program that
comes with your operating system.

=gl

Flle Edit View Image Colors Help

1 5 I
—I CEEC S S S

|Fur Help, click Help Topics an the Help Menu, %
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3.5

Explanation

Displaying Cursor Values

1. Inthe waveform display, click the group from which you wish to read values using
cursors.

2. Click the position in the waveform display area where you wish to read the data.
If you wish to read another point at the same time, drag the cursor. Cursor A
appears at the position where you first clicked; Cursor B appears at the position
where you released the mouse button. The measurement point is displayed where
the waveform and the cursor cross using a yellow circle.

Cursor B

Cursor A
I

3. Click the Display Cursor Rearout button on the toolbar. The Cursor Readout
dialog box opens.

Data number at the
Cursor A position

Move Data number at the Cursor B position
Cursor A Move Cursor B

I E;Difference in the data

Readout

Active channel mark Cursar [ Cursor E Difference number between
Dt Mo, Cursor Aand B
Time Difference 0 00:07:36.000 Relative Time 0001500000 - 000:22:36.
Channel Walueg A “Walug B “Walue B-4 Time: & Tine B
CHOM[Y] Mir -1.424 |10 4218 0.206 | [2004/1 2003 15:36:46.000 | | 2004412003 15:44:22.000
Ma -1.333 ||l 116 0.217 | | 200441 2003 15:36:46.000 | | 20044 2103 15:44:22 000
CHOZY] Mir 0.000 | ||000 0.000 0.000 | | 2004/1 2003 15:36:46.000 | | 2004412003 15:44:22.000
Ma o000 |08 0,000 0.000 | | 200441 2003 15:36:46.000 | | 20044 2003 15:44:22 000
CHOM[Y] Mir 0528 || +OVER 2004112008 14:05:10.000 | | 2004012108 14:12:46.000
Max 0451 || +OVER 2004112008 14:05:10.000 | | 2004012108 14:12:46.000
CHOZY] Mir 0.000 | 0.000 0.000 | | 2004/1 2008 14:05:10.000 | | 2004412408 14:1 2:46.000
Ma o000 )JI0E 0,000 0.000) (200441 2008 14:05:10.000 ) | 20044 2005 14:1 2:46 000

| |
Channel display
color

Alarm indication

The data at the currently displayed cursors are displayed.

Data No.

Value of Cursor A
Value of Cursor B

Value of Cursor B-A
Time of Cursor A

Displays the data number at the Cursor A and B positions.

Time Difference

Displays the time difference between cursors A and B.

Relative Time

Displays the time using the first data of the displayed range between cursors A and B

as a reference.
Value A and Value B

Displays the values and alarms of each channel at cursor A or cursor B. Changes to
red if an alarm occurred, and green if an alarm did not occur. The value is blank if no

data exists at the cursor position.
Value B-A

Time of Cursor B

Displays the result of subtracting the values at cursor A from those at cursor B.

Time A and Time B

Displays the time at cursors A and B.

IM WX201-01E
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3.5 Displaying Cursor Values

Normal and MinMax Format Display
Values of channels In Normal format are displayed in a single row. Values of
channels in MinMax format are displayed in two rows, one for the minimum and
maximum value at the cursor position.

Switching the Active Channel
You can switch the active channel. The active channel mark is displayed between the
waveform number and its color. Click the box of the channel you wish to make active.
This changes the active channel in the trend display screen as well.

Moving Cursors
You can move the cursor positions on the trend display using the Up and Down
buttons.

Note

e The cursors used to display cursor values and those used to specify the interval for
statistical computation over an area are the same.

e The Cursor Readout dialog box and opens. The Computation Results dialog box can be
displayed at the same time.

» If you click a different group in the Trend display screen with the Cursor Readout dialog box
open, the Cursor Readout dialog box displays the cursor values of the selected group.

* You can change the cursor positions in the trend display screen while the Cursor Readout
dialog box is open.

Deleting Cursors

Click the ﬁ button (Erase Cursor button) on the Trend display toolbar. The cursors are
cleared as well as the cursor values displayed in the Cursor Readout dialog box.
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3.6

Displaying Computed Results (Statistics)

1. Inthe waveform display screen, click the tab of the group on which you wish to

perform statistical computation over an area.

2. Click the start point of the computation area in the waveform display area, then
drag the cursor to define the area and end point (use the cursor in the same
manner as in section 3.5, iDisplaying Cursor Values.”

3. Click the Statistics button on the toolbar. The Statistics dialog box opens.

- S|

Channel iy Mt ER higan RMS Start Time End Time i
Wi CHO1[Y] hfiny -2.159 2156 4315 -0.280 1.458 200412003 153646000 | 2004/12/03 15:44:22.000
Ia -2.159 2156 4315 -0.232 1451 20041 2003 153646000 | 2004/1 2003 15:44:22.000
W2 CHO2[Y] hfiny 0.000 0.000 0.000 0.000 0.000 200412003 153646000 | 20041 2003 15:44:22.000
Ia 0.000 0.000 0.000 0.000 0.000 200412003 153646000  2004/1 2003 15:44:22.000
W3 CHO1[Y] hfiny -0.528 2199 2727 0.963 1276 20041 2008 140510000 | 2004/1 2008 14:1 2:46.000
Ia -0.431 2189 2530 1.0035 1.283 20041 2008 140510000 2004/1 2408 14:1 2:46.000
W4 CHO2[Y] hfiny 0.000 0.000 0.000 0.000 0.000 200412008 140510000 | 20041 2005 14:12:46.000

Mz

0.000

0.000

0.000

0.000

0.000

200411 2008 14:05:10.000

20041 2005 14:12:46.000

| N, | Cciculste | | Clos= |

Progress bar

Channel display
color

Explanation

mopulp Aejdsi@ puail 8yl jo uoliesadO ST

Specify using two cursors the interval over which computation is to be performed.
If the cursors are not displayed, all the data are used in the statistical computation.
The statistical parameters are the minimum value, the maximum value, the P-P value
(maximum - minimum), the mean value, and the rms value. The computation is executed
when the dialog box is displayed, or when you click the Calculate button.
(Channels in Normal format are displayed in a single row. Values of channels in MinMax
format are displayed in two rows, one for the minimum and maximum value at the cursor
position. )
Min and Max
Shows the maximum and minimum values of the range selected by the cursors, or the
entire range.
PP
Shows the difference between the maximum and minimum values of the range
selected by the cursors, or the entire range.
Mean
Shows the mean values of the range selected by the cursors, or the entire range.
RMS
Shows the RMS values of the range selected by the cursors, or the entire range.
Start Time and End Time
Shows the start and end times for computation for each channel.
Progress Bar
Displays the execution status of the computation.
Calculate button
Recalculates the statistics. If you change the positions of cursors while the Statistics
dialog box is open, click this button to refresh the computed results.
Note
» The cursors used to display cursor values and those used to specify the interval for
statistical computation over an area are the same.
* The Statistics dialog box and Cursor Value dialog box can be displayed at the same time.
» The statistical results are not linked to cursor movements or switching of groups. After any

such changes are made, click the Statistics button or the Calculate button to recalculate and
display the results.
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3.7 Saving and Loading Trend Settings

Saving Data Trend Settings

Procedure

Explanation

1. click [id (the Save button) in the DataBrowser window or choose File > Save
current trend configuration as from the menu bar. The Save the trend settings

dialog box appears.

he trend settings.

File Lizt I

Alxll_ pelete button

Trend settings file

B Q- — Update button

File: Mame
5 ME100-YView-A001 oy
R0 00-Wiery-S002 .k
R0 00-Wiery - 2003 .l
Trend-2001 .dhy
Trend-2002.dhy
~latest.adby

2lzlz 2121

1
2
=l
4
5
B

Comment
Trend-Feb-09-2005
Trend-Feb-09-2005
Trend-Feb-09-2005
Feh-14-2005
Feh-14-2005
Trend-Feb-09-2005

Drag to change the column width

File Mame |

Commert |

Save |I Cancel |

2. Enter a file name and comment and click the Save button.

The currently displayed trend settings are saved.

File List

Displays the trend settings file name and comments saved on the local host.

Delete the selected file button

Deletes the selected trend settings file.

Update button

Updates the trend settings file list.

File Name

Enter the name of the file you wish to save (an extension is automatically added).

Comment

Enter comments to be saved with the file. Up to 255 alphanumeric characters can be

entered.
Save button

Saves the settings file under the specified file name on the local host.

Note

After saving a trend settings file, the saved file name and comment appears in the text box the
next time you open the Save the trend settings dialog box (these items are blank if no settings
have been saved previously, or when starting up the software). Also, when you select a file in
the Save the trend settings dialog box, the file and comment are displayed in the input boxes at
the bottom of the window. This allows you to conveniently overwrite settings.
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3.7 Saving and Loading Trend Settings

Opening Trend Settings from a Local Host

Procedure

Explanation

1. Click @@ (the Open button) in the DataBrowser window or choose File> Open
from the menu bar. The Open dialog box is displayed.

= Lpen E— ol pelete button

Local Host_!—Hosts on network |

File List 720 Update button
File Mame Commert

1 2% MY 00-View-A001 dby Trend-Feb-03-2005

2 2% MY00-View-A002 doy Trend-Feb-03-2005

3 2% MY100-View-A003 doy Trend-Feb-03-2005

4 2% Trend-A001 dbv Feh-14-2005

5 2% Trend-A002 dby Feh-14-2005

B 2% ~latest.dby Trend-Feb-03-2005

t Drag to change the column width

Double-click a number to open the file

El [&]

File Type |Trend settings file.dbw) j

| Cpen || Cancel |
L L -

2. Select a file and click Open, or double-click the file number. The Information
dialog box opens.

5

M4952
Replace the current trend settings with the selected setkings?

3. Click the Yes button. The trend settings loaded from the trend settings file are
displayed. Click No to close the Information dialog box.

File List
Displays the name of the settings file and comments saved on the local host.

Delete the selected file button
Deletes the selected file.

Update button
Updates the displayed file list.
File Type
If you select all files (.dbc; .dbv), the saved search settings files and display settings
files are displayed.
If you select Search settings file (.dbc), only the search settings files are displayed.
If you select Trend settings file (.dbv), only the display settings files are displayed.
Open button
Opens the settings file selected in the File List. (When a trend settings file is opened,
the Trend display window becomes active.) When a search settings file is opened, the
Search window becomes active.

Cancel button
Closes the Open dialog box.

IM WX201-01E
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3.7 Saving and Loading Trend Settings

Opening Trend Settings indstop from a Network Host

Procedure

1. Click @ on the toolbar or choose File> Open from the menu bar. The Open
dialog box is displayed.

2. Click the Hosts on network tab. The Hosts on network tab is displayed.

3. Click the Update button. The names of hosts running DataBrowser, and their
corresponding files names and comments are displayed.

=10l |

Host List {y— Update button

Host Mame

1 CPCODM-05713-02

Double-click a number to open the file

Fle List Drag to change the column width

H[ast Mame  CPCO01-05713-02 /\
File Marme Commert

1 P MX100-View-BO01 .dibyv Trend-Feh-05-2005
2 25 MX100-View-BO02 dibyv Trend-Feh-05-2005
File Type Trend settings file.dbw) j
Open Cancel

4. Select a host from the Host List. The a list of files saved on the selected host is
displayed.

5. Select a file from the list that you wish to load and click Open, or double-click the
file number. The Information dialog box opens.

x4

M4952
Replace the current trend settings with the selected settings?

6. Click the Yes button. The trend settings loaded from the trend settings file are
displayed. Click No to close the Information dialog box.

Explanation

Host List
The Host List displays the names of any hosts on the network that are running

DataBrowser.

File List
Displays the settings files and comments saved on the host selected in the host list.

Host Name
Displays the name of the host selected in the host list.

Update button
Updates the host list and file list.

File Type, Open Button, and Cancel Button
See Opening Trend Settings Files from a Local Host.
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3.8 Converting Data Formats

Procedure

1. Open the waveform display screen and display the waveforms of the data you
wish to convert.

2. Select a range to convert using the cursors (if no cursors are displayed all data

will be converted). Click =] in the waveform display screen toolbar. The Data
Conversion dialog box opens.

Conversion Type —| Select th heck b f
elect the check box o
W . A
L— m Dlisst Tl ] the desired conversion
Start 450 200412103 15: 36:45.000 type to turn it ON
End &7a 2004412003 15:44:22.000
Step Setting

¥ wiite Measured point of the following channel : W01 CHO1 i Select... |

Qutput File S \DataBroweseribinteng'ProjectiCutputyOutput xls | File ...

3. Select a conversion type of Excel, Text, or Lotus. To change the range of data to
be converted, specify a Start and End point.

4. Enter the number of steps. (See Explanation for details.)

5. To select a channel whose interval is to be used for the interval during data
conversion, select the Write Measured point of the following channel check box
and click the Select button. The Selection dialog box opens. (See Explanation for
details.)

Jsetection |
CH CHO2 CHM

CHO2 CH32 CH33
CH35

Select the channel for output of measured points

6. If you click channel whose measured points are output, that channel is displayed
in the Data Conversion dialog box.

7. Click the File button. The File name dialog box opens.

rilename 21X

Save in: |@ Output j - e

File name: I Ok I
Save as type: |E:-:ce| Files [*.xls] j Cancel |

4
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3.8 Converting Data Formats

Explanation

8. Enter a destination folder and file name and click the OK button.

The name of the output file appears in the Data Conversion dialog box.

9. Click the Start button.

Conversion Type
|]7 Excel [ Text [T Lotus

Start 450 200442103 15:36:46.000
End 675 200412003 15:44:22.000
Step Setting

¥ \rite Measured point of the following channel © W01 : CHO1 I Select... |

Output File  CDataBroweserbinteng ProjectOutputOutput s | File ...

ey | start | [ cloce

Conversion Type
Excel
Data that can be opened using Microsoft’s spreadsheet application Excel version 8.0
(Excel97) or later. The extension is .xIs.
Text
Text data with each data point separated by a comma. The extension is .txt.
Lotus
Data that can be opened using Lotus”spreadsheet application 1-2-3 version 2.0 or
later. The extension is .wj2.
Start and End Points
You can select a range of data to convert. If cursors are placed in the trend display
screen, the range determined by the cursors defines the start and end points. If no
cursors are displayed, all the first and last data of all the data represent the start and
end points. Also, the start and end times are displayed to the right of the entry boxes.
Step Setting
You can specify an interval for data conversion output. This area includes the setting
for the number of steps, and a setting for specifying the channel whose measured
points are to be output (Write Measured point of the following channel).
< If the Write Measured point of the following channel check box is not selected, the
measured points of all channels assigned to the group are output, and the smallest
unit interval is used as the reference interval.
< If the Write Measured point of the following channel check box is selected, the
interval of the selected channel is used as the reference interval.
« By specifying the number of steps, rather than outputting all points in the range
(steps = 1), you can thin the data by outputting only the points sampled at certain
intervals.
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3.8 Converting Data Formats

The figure below shows an example of output when the Write Measured point of
the following channel check box is not selected, the smallest unit interval (reference
interval) is 0.5 s, and the number of steps is 1 (if the steps were set to 3, samples
would be output every 1.5 s).

Minimum unit interval i A A A A A A A A A
(0.5s) H ; ; ; ; ; :

CHO1(1.5s)
CH02(0.5s)
CHO03(1.0s)

R R

T
/
T
T
/
T
/
T
T
/
T
T
/
T

CH04(2.0s)

L
---11
R R S
---11

CHO5(1.55)

B n e s O

Lh

v

PR S T

v

Lh

v

Output (0.5 s)

The squares represent the output of measured points on each channel (0.5 s)
If the Write Measured points of the followimg channel check box is selected
and channel 3 is also selected, measured points on each channel are output
every 1ls.

O: Measurement point of each channel

Note

« If the output points are not measured points, the points directly after are output.
* When the Write Measured point of the following channel check box is selected, the start and
end times on the right are those of the selected channel.

Example of the Converted Data

A | B ¢ | b [ E | F & | H [ 1 [ .
| 47 |Measurement data
| 45 |Channel CHXN CHo2
| 48 | Taghlo
| 50 |TagComment
51 |Unit W W
| 52 |IntenalSec) 2.000 2.000
| 53 |Davs Time Second  Date Time Second  Value(hind Value(ha) Date Time
| 54 | 0002114 0.000 2004/12/015:43.00 0.000 0.063 0218 2004/12/015:43
| 55 | 0002116 0.000/2004,/12/015:43.02 0.000 —0.076 0.063 2004/12/015:43
| 56 | 0002118 0.0002004/12/01543.04 0.000 —0.200 —-0.076 2004/12/01543
| 57 | 00021 20 0.000 2004/12/015:43.06 0.000 —0.325 —0.2002004/12/015:43
| 58 | 0/00:21 22 0.000 2004/12/015:43.08 0.000 —0.448 -0.325 2004/12/015:43
| 59 | 000:21 24 0.000/2004/12/015:4310 0.000 G CHERA0) -0.448 2004/12/015:43
G0 | 00021 26 0.0002004/12/0154312 0.000 —0.689 —-0.5702004/12/01543
| 61 | 00021 28 0.000 2004/12/015:4314 0.000 —0.806 -0689 2004/12/015:43

mopulp Aejdsi@ puail 8yl jo uoliesadO )

Notes When Converting Data

There is a limit to the number of data points that Excel and Lotus1-2-3 can handle.
Before executing the conversion, set the channels/groups to be converted, the
conversion range, and the step so that the number of data points is appropriate (see
Automatic Division Function for Conversion Output Files). In addition, if the free
memory space on the PC is low, you may not be able to load the data using Excel or
Lotus 1-2-3.

If you set the save destination to a storage medium that has slow access such as a
floppy disk, the saving of the data may take an extended time. It is recommended that
such storage medium not be selected for the save destination.

Select a save destination with adequate free space.
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3.8 Converting Data Formats

Automatic Division Function for Conversion Output Files

If the number of points to be converted and output is large and you attempt to save all
the points to a single file, the file will exceed the allowable number of rows in Excel or
Lotus 1-2-3, making the file unloadable.
The Automatic Division function automatically creates multiple files that are within the
row number limit of Excel and Lotus 1-2-3. The names of the divided files are the
original file name plus an appended sequence number.

File name format: file name-****.extension (where **** is a four-digit number).

Ex. Output-0003.xls

Excel row limit: 65536

Lotus 1-2-3 row limit: 8192
Automatic division is not available for conversion to text format.
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3.9 Printing Data

Printing

Procedure

1. Open the waveform display screen.

2. Click & (the Print button) on the toolbar or choose File > Print from the menu
bar. The Printout settings dialog box opens.

Printout Settings il

— Print Range

(* Betwaen CUrsors Al

—Colar
& Blacknvhite " Caolar
Print Title —— Enter a comment
to be printed
Cancel (of up to 255 alphanumeric
characters)

3. Select a print range and color, and enter a print title. Click the OK button. The
Print dialog box opens.

— Printer
M ame: Canon LEP-2460 Properties.. |
Shatus:
Type:
Where:
Comment: [~ Print ta file
— Print range Copie:
o« Al Murnber of copies: |1 3:
£ Pages _from'l _to'l
rd Collate
) Selectinn

ak I Cancel |

4. Click the OK button.

Viewing a Print Preview

Procedure

1. Open the trend display screen.

2. Choose File > Print Preview from the menu bar.

[Trend d Trend-A001 dby] =10/ xl
Hext Page | Brev Fage | Twa Paes | Zoom [h | Zopm Dut | Cloze |
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3.9 Printing Data

Explanation

You can print cursor values and statistics along with waveforms from the trend display
screen. To print cursor values and waveforms, open the Cursor Value dialog box before
printing. To print statistics, open the Statistics dialog box before printing. To print cursor
values and statistics, open both dialog boxes before printing.
Print Range

Choose from Between Cursors and All. Selecting Between Cursors prints the

waveforms in the cursor range displayed on the trend display screen on a single page.
Specifying Colors

You can select black/white print or color print.
Print Title

Enter a title to be printed at the top of the paper.
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Chapter 4  Troubleshooting

4.1 Error Messages and Corrective Actions

A message (such as an error message) may appear during operation. The following
describes the meanings of the messages and their corrective actions.

Code Description Corrective Action
E0002 Insufficient memory. Please close at once. Exit all other software programs and restart the OS.
E0004 Invalid license number. Reinstall the software.

Please reinstall.
E0101 Please open from the DataBrowser. This software cannot be opened by itself.

Start it from the DataBrowser.

E4948 Could not initialize communications. Check whether TCP/IP is operating normally.
M4959 Cannot exit while DataBrowser is starting up. Close DataBrowser, then shut down or log off.

Search Folder Registration

Corrective Action

The limit of eight folders that can be registered in the
search folder registration area has been reached. If
you need to register a new folder, first delete one or

more of the folders first.

Code Description
E4925 No more search folders can be registered.
E4940 Same folder ID already exists.

Check the list of registered folders.

A folder with the same ID has already be registered
in the search folder registration dialog box. Either
delete the existing folder from the list, or register the
new folder using a different ID.

E4957 Same folder ID already exists.
Check the search folders.

Same folder ID already exists in the search folder
registration area. Therefore, the new one cannot be
registered. Delete the folder with the same ID from
the registration area, or, register the new folder using
a different ID. If registering with a different ID, use a
folder ID not already listed in the registration area.

E4960 Limit of folders that can be registered exceeded.

If more than two hundred folders would be registered,
registration is denied. If you need to register a new
folder, first delete an existing one from the folder
registration list in the search folder registration dialog
box.

Executing Searches

Code Description

Corrective Action

E4907 No response.

Check whether the network is connected correctly
(cables, hubs, and other hardware), and that no
problems occurred on the network.

E4939 Folder ID not found.

On the host on which the error occured, the search
could not be performed because the folder ID does
not exist in the folder registration of the DataBrowser
being run. Register the search folder on the
DataBrowser on the host on which an error occured.

E4942 Folder not found.

Check whether the folder exists on the DataBrowser
on the host on which an error occured.

E4945 Failed to write file.

Failed to write the search results file. Confirm that the
disc capacity and file system are correct.

E4946 Connection failure.

Check whether the host on which an error occured
exists. If it exists, check whether DataBrowser is
running on that host.

Check whether the network is connected correctly
(cables, hubs, and other hardware), and that no
problems occurred on the network.

IM WX201-01E
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4.1 Error Messages and Corrective Actions

Code Description Corrective Action

E4947 DataBrowser not found. Software may be running on the same port (50285)
used by DataBrowser. Check the host on which the
error occured.

E4956 The number of data files that meet the criterion If the number of data files that meet the search

exceeded the limit.

the upper limit of 60000, narrow down your search
conditions and perform the search again.

Saving and Loading Settings and Search Results

Code Description Corrective Action

E0211 Cannot write to the file. Failed to save the file. Confirm that the disc capacity
and file system are correct.

E0212 Cannot read file. Confirm that a file exists, that the software supports it,
and whether the file system is correct.

E0213 Cannot open the file. Confirm that a file exists, that the software supports it,
and whether the file system is correct.

E4955 Failed to delete file. When files were deleted, one or more files could not
be completely deleted.

M4959 No search results. Since no search results files are in the data search

window, search results could not be saved.

Saving and Loading Settings and Search Results

Code Description

Corrective Action

E4961 Failed to copy data file.

Failed to copy data file. Check whether the disk
capacity in the copy destination is sufficient, whether
the copy destination folder is write-protected, and
whether the file system is correct.

E4962 The copied data file exists under a different name.

A data file of the same name was found in the copy
destination. Change the name. In this case, save
the file in the copy destination under the name, “copied
file name-four digit number.extension.” The four digit
number starts with 0000, followed by 0001, and so
on.
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